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FCC Statement

The devices named in this manual comply with Part 15 of the FCC Rules. Opera-
tion is subject to the following two conditions: (1) the devices may not cause harm-
ful interference, and (2) the devices must accept any interference received, including
interference that may cause undesired operation.

NOTE: This equipment has been found to comply with the limits for a Class A dig-
ital device, pursuant to Part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful inter-
ference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful inter-
ference in which case the user will be required to correct the interference at his
own expense.
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Sicherheitshinweise

Sicherheitshinweise

Bitte lesen Sie die folgenden Sicherheitshinweise aufmerksam durch, bevor Sie das
G&D-Produkt in Betrieb nehmen. Die Hinweise helfen Schaden am Produkt zu ver-
meiden und méglichen Verletzungen vorzubeugen.

Halten Sie diese Sicherheitshinweise fiir alle Personen griffbereit, die dieses Produkt
benutzen werden.

Befolgen Sie alle Warnungen oder Bedienungshinweise, die sich am Gerdt oder in
dieser Bedienungsanleitung befinden.

A

Vorsicht vor Stromschligen

Um das Risiko eines Stromschlags zu vermeiden, sollten Sie das Gerét nicht 6ff-
nen oder Abdeckungen entfernen. Im Servicefall wenden Sie sich bitte an unsere
Techniker.

Ziehen Sie den Netzstecker des Gerits vor Installationsarbeiten

Stellen Sie vor Installationsarbeiten sicher, dass das Gerat spannungsfrei ist. Zie-
hen Sie den Netzstecker oder die Spannungsversorgung am Gerét ab.
Stindigen Zugang zu den Netzsteckern der Gerite sicherstellen

Achten Sie bei der Installation der Gerdte darauf, dass die Netzstecker der
Geréte jederzeit zugdnglich bleiben.

Liiftungs6ffnungen nicht verdecken

Bei Geritevarianten mit Liftungsoffnungen ist eine Verdeckung der Liftungs-
offnungen unbedingt zu vermeiden.

Korrekte Einbaulage bei Geraten mit Liiftungs6ffnungen sicherstellen

Aus Griinden der elektrischen Sicherheit ist bei Gerdten mit Liiftungséffnungen
nur eine aufrechte, horizontale Einbauweise zuléssig.

Stolperfallen vermeiden

Vermeiden Sie bei der Verlegung der Kabel Stolperfallen.

Geerdete Spannungsquelle verwenden
Betreiben Sie dieses Gerdt nur an einer geerdeten Spannungsquelle.

Verwenden Sie ausschliefilich das G&D-Netzteil

Betreiben Sie dieses Gerat nur mit dem mitgelieferten oder in der Bedienungsan-
leitung aufgefiihrten Netzteil.

Betreiben Sie das Gerit ausschlieflich im vorgesehenen Einsatzbereich

Die Geriéte sind fiir eine Verwendung im Innenbereich ausgelegt. Vermeiden Sie
extreme Kaélte, Hitze oder Feuchtigkeit.
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Die DP-Vision-IP-Serie

Die DP-Vision-IP-Serie

Die KVM-Extender der DP-Vision-IP-Serie bestehen aus einem Rechnermodul und
einem Arbeitsplatzmodul.

An das Rechnermodul (DP-Vision-IP-CPU) schliefen Sie den zu bedienenden Rechner
und optional einen Arbeitsplatz an. Den entfernten Arbeitsplatz schliefen Sie an
das Arbeitsplatzmodul (DP-Vision-IP-CON) an.

Das Rechner- und das Arbeitsplatzmodul werden mit Twisted-Pair-Kabeln der
Kategorie 5e (oder hoher) tiber ein IP-basiertes Gigabit-Ethernet verbunden.

Bei Beachtung der max. Lange von Teilstrecken zwischen zwei aktiven Netzwerk-
komponenten (jeweils bis zu 100 Meter) ist die gesamte Ubertragungsldnge unbe-
schrankt.

HINWEIS: Alternativ konnen Sie das Rechnermodul mittels einer direkten Twi-
sted-Pair-Verkabelung der Kategorie 5e (oder hoher) mit dem Arbeitsplatzmodul
verbinden.

Die Signaliibertragung zwischen dem Rechner- und dem Arbeitsplatzmodul erfolgt
komprimiert und verschliisselt (AES-128) mittels G&Ds KVM-over-IP™-Technologie
uber das Gigabit-Ethernet (Layer 3).

Bei ausreichend nutzbarer Bandbreite des Gigabit-Ethernets wird das Videosignal
mit verlustfreier Videoqualitdt und nahezu latenzfrei wiedergegeben. Mittels manu-
ellem Bandbreiten-Management konnen Sie die Ubertragung an unterschiedliche
Bandbreitenanforderungen anpassen (siehe Bandbreite limitieren auf Seite 17).

Die Bedienung des Rechners kann wahlweise am entfernten Arbeitsplatz des
Arbeitsplatzmoduls oder am lokalen Arbeitsplatz des Rechnermoduls erfolgen.

WICHTIG: Die Dateniibertragung der Gerate der DP-Vision-IP-Serie ist nicht kompa-
tibel zu G&D-Gerédten anderer Serien!
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Lieferumfang

Lieferumfang

Das KVM-Extender-System besteht aus einem Rechner- (DP-Vision-IP-CPU) und
einem Arbeitsplatzmodul (DP-Vision-IP-CON).

Zusétzlich befindet sich folgendes Zubehor im Lieferumfang der Geréte:

= 2 X Stromversorgungskabel (PowerCable-2 Standard)

= 1 x Videokabel (DP-Cable-M/M-2)

= 1 x USB-Geritekabel (USB-AM/BM-2)

= 2 X Audio-Kabel (Audio-M/M-2)

= 1 x serielles Anschlusskabel (RS232-M/F-2)

= 1 x Servicekabel (USB-Service-2)

= 1 x Installations- und Bedienhandbuch

= 1 X Bedienhandbuch fiir Webapplikation Config Panel
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Installation

Installation

Vorbereitung

WICHTIG: Stellen Sie bei der Standortwahl der Geréte sicher, dass die zuldssige
Umgebungstemperatur (siehe Technische Daten auf Seite 57) in der unmittelbaren
Néhe eingehalten und nicht durch andere Geréte beeinflusst wird.

1. Stellen Sie sicher, dass der an das Rechnermodul anzuschlieRende Rechner aus-
geschaltet ist. Falls der Rechner mit einer Tastatur und einer Maus verbunden ist,
ziehen Sie die Kabel der Eingabegerite aus den Schnittstellen.

2. Platzieren Sie das Rechnermodul (DP-Vision-IP-CPU) in der Ndhe des Rechners.

HINWEIS: Die maximale Kabelldnge zwischen dem Rechnermodul und dem
anzuschliefenden Rechner betragt fiinf Meter.

3. Platzieren Sie das Arbeitsplatzmodul (DP-Vision-IP-CON) in der Néhe des entfern-
ten Arbeitsplatzes.

HINWEIS: Die maximale Kabelldnge zwischen dem Arbeitsplatzmodul und
den Gerdten des Arbeitsplatzes betragt fiinf Meter.

4. Entnehmen Sie die mitgelieferten Kabel der Verpackung und legen Sie diese fiir
die Installation der Gerite bereit.
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Installation

Installation des Rechnermoduls

An das Rechnermodul DP-Vision-IP-CPU schliefien Sie den Rechner an, dessen Signale
an den entfernten Arbeitsplatz tibertragen werden. Falls gewiinscht, kdnnen Sie einen
lokalen Arbeitsplatz an das Rechnermodul anschlieffen.

Verbindung mit einem lokalen Netzwerken herstellen

Dil:l

Network

Network: Stecken Sie das als Zubehor erhiltliche Twisted-Pair-Kabel der Kategorie 5
(oder hoher) ein. Verbinden Sie das andere Ende des Kabels mit dem Gigabit-Ethernet.

WICHTIG: Verbinden Sie das Rechnermodul fiir die Ersteinrichtung mittels einer
direkten Twisted-Pair-Verkabelung der Kategorie 5e (oder hoher) zundchst mit
dem Arbeitsplatzmodul.

Tastatur- und Mausschnittstelle(n) des lokalen Rechners
anschlieen

@ @A

Keyb. CPU Mouse CPU USB CPU

HINWEIS: Die Signale von Maus und Tastatur beider Arbeitsplatze konnen wahi-
weise tiber die USB-Schnittstelle USB CPU oder die PS/2-Schnittstellen Mouse CPU
und Keyb. CPU an den Rechner iibertragen werden.

USB CPU: Verbinden Sie eine USB-Schnittstelle des Rechners mit dieser Schnittstelle.
Verwenden Sie hierzu das Kabel USB-AM/BM-2.

Keyb. CPU: Verbinden Sie die PS/2-Tastatur-Schnittstelle des Rechners mit dieser
Schnittstelle. Verwenden Sie hierzu ein separat erhéltliches PS/2-Kabel (PS/2-M/M-2).

Mouse CPU: Verbinden Sie die PS/2-Maus-Schnittstelle des Rechners mit dieser Schnitt-
stelle. Verwenden Sie hierzu ein separat erhéltliches PS/2-Kabel (PS/2-M/M-2).
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Installation

Videoausgang des Rechners anschlieBen

DP CPU

DP CPU: Verbinden Sie den Videoausgang des Rechners mit dieser Schnittstelle. Ver-
wenden Sie hierzu das Kabel DP-Cable-M/M-2.

Audio- und RS232-Schnittstellen verbinden

RS232

® ® OO

In Line Out

HINWEIS: Die Audio-Daten werden in der Standardeinstellung des KVM-Exten-
ders zwischen den Switches iibertragen.

Zusitzlich kénnen Sie im OSD die Ubertragung der RS232-Daten aktivieren und
alternativ die Ubertragung der Audio-Daten deaktivieren (siehe Signale (de)aktivie-
ren auf Seite 18).

Line In: Verbinden Sie die Line-Out-Schnittstelle des Rechners mit dieser Schnittstelle.
Verwenden Sie hierzu ein Audio-Anschlusskabel Audio-M/M-2.

Line Out: Verbinden Sie die Line-In-Schnittstelle des Rechners mit dieser Schnittstelle.
Verwenden Sie hierzu ein Audio-Anschlusskabel Audio-M/M-2.

RS232: Verbinden Sie eine 9-polige serielle Schnittstelle des Rechners mit dieser
Schnittstelle. Verwenden Sie hierzu das Kabel RS232-M/F-2.
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Installation

Optional: Lokalen Arbeitsplatz anschlieBen

Keyb./Mouse

DP Out

HINWEIS: Die Tastatur des lokalen Arbeitsplatzes konnen Sie wahlweise als PS/2-
oder USB-Gerét anschliefen.

TIPP: Verwenden Sie den Adapter MD6M-2xMD6F (A6400043) zum gleichzeitigen
Anschluss einer PS/2-Tastatur und einer PS/2-Maus.

Keyb./Mouse: Schliefen Sie die Maus und/oder die Tastatur des lokalen Arbeitsplat-
Zes an.

DP Qut: Schliefen Sie den Monitor des lokalen Arbeitsplatzes an.

Stromversorgung herstellen

Red. Power

Red. Power: An diese Buchse konnen Sie ein optionales Tischnetzteil anschlieflen.
Hierdurch wird eine zweite, redundante Stromversorgung des Gerétes erreicht.

Main Power

Main Power: Stecken Sie ein mitgeliefertes Kaltgerétekabel ein.
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Installation

Installation des Arbeitsplatzmoduls

An das Arbeitsplatzmodul DP-Vision-IP-CON schliefen Sie den entfernten Arbeits-
platz an. An diesem Arbeitsplatz konnen Sie den am Rechnermodul angeschlosse-
nen Rechner bedienen.

Verbindung mit einem lokalen Netzwerk herstellen

DHD

Network

Network: Stecken Sie ein als Zubehor erhiltliches Twisted-Pair-Kabel der Kategorie 5
(oder hoher) ein. Verbinden Sie das andere Ende des Kabels mit dem Gigabit-Ethernet.

HINWEIS: Verbinden Sie das Rechnermodul fiir die Ersteinrichtung mittels einer

direkten Twisted-Pair-Verkabelung der Kategorie 5e (oder hoher) mit dem
Arbeitsplatzmodul.

Tastatur und Maus des Arbeitsplatzes anschlielen

Mouse

Generic

Keyb./Mouse  Keyb.

HINWEIS: Die Maus und die Tastatur des Arbeitsplatzes konnen Sie wahlweise als
PS/2- oder als USB-Gerét anschliefien.

Keyb./Mouse: Schlieflen Sie die USB-Maus und/oder die -Tastatur des Arbeitsplatzes an.

Generic: In der Standardeinstellung konnen Sie an diese Schnittstelle eine weiteres
USB-Eingabegerét oder ein unterstiitztes Display bzw. Tablet anschlief}en.

Aktivieren Sie den Generic-HID-Modus (siehe USB-HID-Modus auswdhlen auf Seite 40),
wenn Sie ein anderes USB-Eingabegerat anschliefien mochten. Die Daten des USB-Ein-
gabegerdtes werden in diesem Modus unverdindert an das Rechnermodul tibertragen.

WICHTIG: Bei aktiviertem Generic-HID-Modus kann das OSD mit einer Tastatur an
der Generic-Buchse nicht bedient werden.

Keyb.: Schlieen Sie die PS/2-Tastatur des Arbeitsplatzes an.
Mouse: Schliefen Sie die PS/2-Maus des Arbeitsplatzes an.
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Installation

Monitor des Arbeitsplatzes anschlieen

DP Out

DP Out: Schlieffen Sie hier den Monitor des Arbeitsplatzes an.
Audio- und RS232-Schnittstellen verbinden

RS232

oo

® @®

Micro In - Speaker

HINWEIS: Die Audio-Daten werden in der Standardeinstellung des KVM-Exten-
ders zwischen den Switches iibertragen.

Zusétzlich kénnen Sie im OSD die Ubertragung der RS232-Daten aktivieren und
alternativ die Ubertragung der Audio-Daten deaktivieren (siehe Signale (de)aktivie-
ren auf Seite 18).

Micro In: Schlieflen Sie hier gegebenenfalls ein Mikrofon an.

Speaker: Schliefen Sie die Lautsprecher oder ein anderes Audioausgabegerdt des
Arbeitsplatzes an.

R$232: Verbinden Sie das serielle Endgerat mit dieser Schnittstelle.

Stromversorgung herstellen

Red. Power

Main Power

Main Power: Stecken Sie ein mitgeliefertes Kaltgerétekabel ein.

Red. Power: Stecken Sie ein mitgeliefertes Kaltgeratekabel ein. Hierdurch wird eine
zweite, redundante Stromversorgung des Arbeitsplatzmoduls erreicht.
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Inbetriebnahme

Inbetriebnahme

Nach der ordnungsgeméfien Installation der KVM-Extender kdnnen diese sofort in
Betrieb genommen werden.

Beachten Sie folgende Einschaltreihenfolge bei der Erstinbetriebnahme der Module:
1. Schalten Sie das Arbeitsplatzmodul DP-Vision-IP-CON ein.
2. Schalten Sie das Rechnermodul DP-Vision-IP-CPU ein.

3. Schalten Sie den, am Rechnermodul angeschlossenen, Rechner ein.

HINWEIS: Die empfohlene Einschaltreihenfolge fiir die Erstinbetriebnahme stellt
sicher, dass die KVM-Extender die Eigenschaften des angeschlossenen Monitors
auslesen und an den Rechner weiterleiten konnen (siehe DDC-Weiterleitung mit
Cache-Funktion auf Seite 53).

Startvorgang

Nach dem Einschalten des Rechner- bzw. des Arbeitsplatzmoduls signalisieren die
LEDs an der Frontseite den Betriebszustand des Moduls.

Weitere Hinweise hierzu erhalten Sie im Kapitel Statusanzeigen ab Seite 56.

On-Screen-Display des Arbeitsplatzmoduls

Beim Start des Arbeitsplatzmoduls werden Informationen iiber den Startvorgang
sowie die Firmware-Versionen und ID-Nummern der verbundenen Module auf dem
Monitor des Arbeitsplatzes angezeigt.

Zusitzlich werden der Local hotkey (Standard: Alt+Num) zum Offnen des lokalen OSD
des Arbeitsplatzmoduls und der Remote hotkey (Standard: Strg+Num) zum Offnen des
entfernten OSD des Rechnermoduls angezeigt.

TIPP: Betdtigen Sie die Pause-Taste, um den Vorgang anzuhalten. Ein Tasten-
druck auf die Leertaste fithrt den Vorgang fort.
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Ersteinrichtung der KVM-over-IP™-Verbindung

Ersteinrichtung der KVM-over-IP™-
Verbindung

WICHTIG: Andern Sie die voreingestellten IP-Adressen, bevor Sie mehrere Rech-
ner- bzw. Arbeitsplatzmodule in das Produktivnetzwerk integrieren!

Die Signaliibertragung zwischen dem Rechner- und dem Arbeitsplatzmodul erfolgt
mittels G&Ds KVM-over-IP™-Technologie tiber ein Gigabit-Ethernet (Layer 3).

Fiir die Kommunikation zweier Module miteinander sind verschiedene Einstellungen
erforderlich. In der Werkseinstellung sind die Module so konfiguriert, dass ein Rech-
ner- und ein Arbeitsplatzmodul sofort eine Direktverbindung aufbauen konnen.

Alle Rechnermodule werden mit der IP-Adresse 172.17.0.10 und alle Arbeitsplatzmo-
dule mit der IP-Adresse 172.17.0.11 vorkonfiguriert.

TIPP: Falls Thnen die IP-Adresse eines bereits konfigurierten Arbeitsplatz- oder
Rechnermoduls unbekannt ist, konnen Sie diese iiber die Log-Ausgaben des Geréa-
tes ermitteln. Weiterfiihrende Informationen finden Sie im Abschnitt Ermittlung
der Netzwerkeinstellungen tiber den Service-Port auf Seite 53.

Werkseinstellung der Module

TIPP: Sie konnen die Werkseinstellungen iiber den Fronttaster eines jeden
Moduls wiederherstellen. Folgen Sie hierzu den Schritten im Abschnitt Wiederher-
stellung der Standardeinstellungen auf Seite 21.

Die Werkseinstellung der Module ermdglicht den schnellen Aufbau einer Direktver-
bindung zwischen einem Rechner- und einem Arbeitsplatzmodul. Uber das OSD
konnen Sie die Konfiguration beider Module nach der Inbetriebnahme anpassen.

Die IP-Adressen und die KVM-over-IP-Einstellungen sind wie folgt vorkonfiguriert:

WERKSEINSTELLUNG DES RECHNERMODULS (CPU),

IP-Adresse: 172.17.0.10
Netzmaske 255.255.0.0
Control Port: 18246
Communication Port: 18245
Data Port: 18244
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WERKSEINSTELLUNG DES ARBEITSPLATZMODULS (CON)

IP-Adresse: 172.17.0.11
Netzmaske 255.255.0.0
Local Control Port: 18246
Local Communication Port: 18245
Local Data Port: 18244
Remote Host: 172.17.0.10
Remote Control Port: 18246

HINWEIS: Fir den Aufbau der KVM-over-IP-Verbindung durch das Arbeitsplatzmo-
dul sind die Angabe der IP-Adresse des Rechnermoduls (Host) sowie die Angabe
des Control Ports des Rechnermoduls erforderlich.

Die Konfiguration der Communication Ports und Data Ports werden automatisch zwi-
schen beiden Modulen ausgetauscht.

Vorbereitungen fiir die Ersteinrichtung

= Installieren Sie das Rechner- und das Arbeitsplatzmodul (s. Seite 4 ff.).

= Verbinden Sie die Network-Schnittstelle des Rechnermoduls fiir die Ersteinrichtung
mittels einer direkten Twisted-Pair-Verkabelung der Kategorie Se (oder hoher)
mit der Network-Schnittstelle des Arbeitsplatzmoduls.

= Schalten Sie das Rechner- sowie das Arbeitsplatzmodul ein (s. Seite 10 ff.).

KVM-over-IP-Verbindung des Rechnermoduls
konfigurieren

Die erforderlichen Konfigurationseinstellungen kénnen Sie direkt am Arbeitsplatz
durchfiihren.

HINWEIS: Sie konnen am Arbeitsplatz mit dem Local Hotkey (Standard: Ali+Num)
das lokale OSD des Arbeitsplatzmoduls und mit dem Remote Hotkey (Standard:
Strg+Num) das entfernte OSD des Rechnermodus aufrufen und konfigurieren.

Wiéhrend des Startvorgangs des Arbeitsplatzmoduls werden die Einstellungen bei-
der Hotkeys angezeigt (siehe Startvorgang auf Seite 10).

WICHTIG: Das OSD des Rechnermoduls kann nur aufgerufen werden, wenn eine
KVM-over-IP-Verbindung zum Rechnermodul aufgebaut ist.

Andern Sie daher zundchst die Konfiguration des Rechnermoduls!
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Konfiguration der Netzwerkschnittstelle

So konfigurieren Sie die Netzwerkschnittstelle:

1. Verwenden Sie den Remote-Hotkey Strg+Num zum Aufruf des
Rechnermodul-OSD.

2. Wihlen Sie die Zeile Network setup und betétigen Sie die Eingabetaste.
3. Wiéhlen Sie die Zeile Interfaces und betatigen Sie die Eingabetaste.

4. Erfassen Sie im Abschnitt Interface A folgende Daten:
Operational Betitigen Sie die F8-Taste zur Auswahl des Betriebsmodus
mode: der Schnittstelle:

= Static: Es wird eine statische IP-Adresse zugeteilt.
= DHCP: Bezug der IP-Adresse von einem DHCP-Server.

IP address: Geben Sie die IP-Adresse der Schnittstelle an.
Im Betriebsmodus DHCP ist keine Eingabe maoglich.

Netmask: Geben Sie die Netzmaske des Netzwerkes an.
Im Betriebsmodus DHCP ist keine Eingabe maoglich.

5. Betitigen Sie die F2-Taste zur Speicherung der durchgefithrten Anderungen.

Konfiguration der globalen Netzwerkeinstellungen

Die globalen Netzwerkeinstellungen stellen auch in komplexen Netzwerken sicher,
dass der KVM-Extender aus allen Teilnetzwerken erreichbar ist.

So konfigurieren Sie die globalen Netzwerkeinstellungen:

1. Verwenden Sie den Remote-Hotkey Strg+Num zum Aufruf des
Rechnermodul-OSD.

2. Wiéhlen Sie die Zeile Network setup und betétigen Sie die Eingabetaste.
3. Wiéhlen Sie die Zeile Interfaces und betatigen Sie die Eingabetaste.
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4. Erfassen Sie im Abschnitt Main Network folgende Daten:

Global Betatigen Sie die F8-Taste zur Auswahl des Betriebsmodus:

HEEEDS = Static: Verwendung von statischen Einstellungen.

= DHCP: Bezug der Einstellungen von einem DHCP-Server.

Hostname: Geben Sie den Host-Namen des Gerétes ein.

Domain: Geben Sie die Doméne an, welcher das Gerdt angehdren soll.
Gateway: Geben Sie die IP-Adresse des Gateways an.

DNS 1: Geben Sie die IP-Adresse des DNS-Servers an.

DNS 2: Geben Sie optional die IP-Adresse eines weiteren DNS-Servers an.

5. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten Anderungen.

Konfiguration der KVM-over-IP-Verbindung

Fir den Aufbau der KVM-over-IP-Verbindung durch das Arbeitsplatzmodul sind die
Angabe der IP-Adresse des Rechnermoduls (Host) sowie die Angabe des Control Ports
des Rechnermoduls erforderlich.

HINWEIS: Die Konfiguration der Communication Ports und Data Ports werden auto-
matisch zwischen beiden Modulen ausgetauscht.

So konfigurieren Sie die KVM-over-IP-Verbindung:

1. Verwenden Sie den Remote-Hotkey Strg+Num zum Aufruf des
Rechnermodul-OSD.

2. Wiébhlen Sie die Zeile KM connection und betdtigen Sie die Eingabetaste.
3. Erfassen Sie im Abschnitt Network setting folgende Daten:

Control port: Geben Sie die Nummer des zu verwendenden Ports ein.
Communication port:  Geben Sie die Nummer des zu verwendenden Ports ein.

Data port: Geben Sie die Nummer des zu verwendenden Ports ein.

4. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten Anderungen.
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KVM-over-IP-Verbindung des Arbeitsplatzmoduls
konfigurieren

Die erforderlichen Konfigurationseinstellungen konnen Sie direkt am Arbeitsplatz
durchfiihren.

HINWEIS: Sie konnen am Arbeitsplatz mit dem Local Hotkey (Standard: Ali+Num)
das lokale OSD des Arbeitsplatzmoduls und mit dem Remote Hotkey (Standard:
Strg+Num) das entfernte OSD des Rechnermodus aufrufen und konfigurieren.

Wihrend des Startvorgangs des Arbeitsplatzmoduls werden die Einstellungen bei-
der Hotkeys angezeigt (siehe Startvorgang auf Seite 10).

Konfiguration der Netzwerkschnittstelle

So konfigurieren Sie die Netzwerkschnittstelle:

1. Verwenden Sie den Local-Hotkey Alt+Num zum Aufruf des
Arbeitsplatzmodul-OSD.

2. Wihlen Sie die Zeile Network und betétigen Sie die Eingabetaste.
3. Wihlen Sie die Zeile Interfaces und betétigen Sie die Eingabetaste.

4. Erfassen Sie im Abschnitt Interface A folgende Daten:

Operational Betétigen Sie die F8-Taste zur Auswahl des Betriebsmodus
mode: der Schnittstelle:

= Static: Es wird eine statische IP-Adresse zugeteilt.
= DHCP: Bezug der IP-Adresse von einem DHCP-Server.

IP address: Geben Sie die IP-Adresse der Schnittstelle an.
Im Betriebsmodus DHCP ist keine Eingabe moglich.
Netmask: Geben Sie die Netzmaske des Netzwerkes an.

Im Betriebsmodus DHCP ist keine Eingabe moglich.

5. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten Anderungen.

Konfiguration der globalen Netzwerkeinstellungen

Die globalen Netzwerkeinstellungen stellen auch in komplexen Netzwerken sicher,
dass der KVM-Extender aus allen Teilnetzwerken erreichbar ist.

So konfigurieren Sie die globalen Netzwerkeinstellungen:

1. Verwenden Sie den Local-Hotkey Alt+Num zum Aufruf des
Arbeitsplatzmodul-OSD.

2. Wihlen Sie die Zeile Network setup und betdtigen Sie die Eingabetaste.

3. Wihlen Sie die Zeile Interfaces und betétigen Sie die Eingabetaste.
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4. Erfassen Sie im Abschnitt Main Network folgende Daten:

Global Betétigen Sie die F8-Taste zur Auswahl des Betriebsmodus:

DISGIONCEE = Static: Verwendung von statischen Einstellungen.

= DHCP: Bezug der Einstellungen von einem DHCP-Server.

Hostname: Geben Sie den Host-Namen des Gerétes ein.

Domain: Geben Sie die Doméne an, welcher das Gerdt angehoren soll.
Gateway: Geben Sie die IP-Adresse des Gateways an.

DNS 1: Geben Sie die IP-Adresse des DNS-Servers an.

DNS 2: Geben Sie optional die IP-Adresse eines weiteren DNS-Servers an.

5. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten Anderungen.

Konfiguration der KVM-over-IP-Verbindung

Fir den Aufbau der KVM-over-IP-Verbindung durch das Arbeitsplatzmodul sind die
Angabe der IP-Adresse des Rechnermoduls (Host) sowie die Angabe des Control Ports
des Rechnermoduls erforderlich.

HINWEIS: Die Konfiguration der Communication Ports und Data Ports werden auto-
matisch zwischen beiden Modulen ausgetauscht.

So konfigurieren Sie die KVM-over-IP-Verbindung:

1. Verwenden Sie den Local-Hotkey Alt+Num zum Aufruf des
Arbeitsplatzmodul-OSD.

2. Wiéhlen Sie die Zeile KVM connection und betdtigen Sie die Eingabetaste.

3. Erfassen Sie im Abschnitt Local folgende Daten:

Control port: Geben Sie die Nummer des zu verwendenden Ports ein.
Communication port:  Geben Sie die Nummer des zu verwendenden Ports ein.

Data port: Geben Sie die Nummer des zu verwendenden Ports ein.

4. Erfassen Sie im Abschnitt Remote folgende Daten:

Host: Geben Sie die IP-Adresse des Rechnermoduls ein.

Control port: Geben Sie die Nummer des im Rechnermodul
konfigurierten Control Ports ein.

5. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten Anderungen.
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Anschluss der Module an das Produktivhnetzwerk

= Trennen Sie die Direktverbindung der Network-Schnittstelle des Rechnermoduls
mit der Network-Schnittstelle des Arbeitsplatzmoduls.

= Verbinden Sie die Network-Schnittstellen beider Module mit dem Gigabit-Ethernet.

Erweiterte Einstellungen der KVM-over-IP-
Verbindung
Bandbreite limitieren

In der Standardeinstellung verwendet der KVM-Extender die maximal zur Verfi-
gung stehende Bandbreite des Gigabit-Ethernets. Mittels manuellem Bandbreiten-
Management koénnen Sie die Ubertragung an unterschiedliche Bandbreitenanforder-
ungen anpassen.

So stellen Sie das Bandbreiten-Limit der KVM-over-IP-Verbindung ein:

1. Verwenden Sie den Remote-Hotkey Strg+Num zum Aufruf des
Rechnermodul-OSD.

2. Wiéhlen Sie die Zeile KVM connection und betitigen Sie die Eingabetaste.
3. Geben Sie in der Zeile Bandwidth limit (Mb/s) das Bandbreiten-Limit in Mb/s fiir die
KVM-over-IP-Verbindung ein.
HINWEIS: Der Wert 0 deaktiviert das Limit.
4. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten Anderungen.

Klassifizierung der IP-Pakete (DiffServ)

Fir QoS-Zwecke (Quality of Service; deutsch: Dienstgiite) haben Sie die Moglich-
keit, Differentiated Services Codepoints (DSCP) zur Klassifizierung der IP-Pakete zu ver-
wenden.

Mittels dieser Klassifizierung konnen Sie die Datenpakete beispielsweise durch
einen Switch priorisieren.

Fiir die IP-Pakete der Keyboard, Maus und Steuerdaten (Communication-Datenpa-
kete) sowie die IP-Pakete der Video-, Audio und RS232-Daten (Data-Datenpakete)
konnen Sie je einen DSCP festlegen.

So konfigurieren Sie die DSCPs der IP-Datenpakete:

1. Verwenden Sie den Remote-Hotkey Strg+Num zum Aufruf des
Rechnermodul-OSD.

2. Wihlen Sie die Zeile KVM connection und betatigen Sie die Eingabetaste.
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3. Erfassen Sie im Abschnitt Network control folgende Daten:

DiffServ Communication: Bestimmen Sie den Differentiated Services Codepoint
(DSCP) der zur Klassifizierung der IP-Pakete der
Communication-Datenpakete verwendet wird.

DiffServ Data: Bestimmen Sie den Differentiated Services Codepoint
(DSCP) der zur Klassifizierung der IP-Pakete der
Data-Datenpakete verwendet wird.

4. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten Anderungen.

Signale (de)aktivieren

In der Standardeinstellung des KVM-Switches werden neben Keyboard-, Video-
und Mausdaten auch die Audio-Daten zwischen den Switches tibertragen.

Zusitzlich kénnen Sie die Ubertragung der RS232-Daten aktivieren und alternativ
die Ubertragung der Audio-Daten deaktivieren.

So (de)aktivieren Sie die Ubertragung des Audio- bzw. RS232-Signals:

1. Verwenden Sie den Remote-Hotkey Strg+Num zum Aufruf des
Rechnermodul-OSD.

2. Wiébhlen Sie die Zeile KM connection und betitigen Sie die Eingabetaste.

3. Wahlen Sie in der Zeile Activated signals das Kontrollkastchen des zu (de)aktivie-
renden Signals mit den Pfeiltasten aus und betétigen Sie die F8-Taste.

4. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten Anderungen.
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Bedienung

Den am Rechnermodul DP-Vision-IP-CPU angeschlossene Rechner konnen Sie
sowohl am entfernten Arbeitsplatz des Arbeitsplatzmoduls als auch am lokalen
Arbeitsplatz des Rechnermoduls bedienen.

Nach der Inbetriebnahme ist die Bedienung des Rechners fiir beide Arbeitsplatze
freigeschaltet.

HINWEIS: Die Monitore des entfernten und des lokalen Arbeitsplatzes zeigen in der
Standardeinstellung gleichzeitig immer das gleiche Bild an.

Im Abschnitt Anderung der Videobetriebsart der Arbeitsplitze auf Seite 34 wird erliu-
tert, wie Sie diese Einstellung d&ndern kénnen.

Konkurrierende Bedienung des KVM-Extenders

Wird an einem Arbeitsplatz eine Eingabe per Tastatur oder Maus durchgefiihrt,
sperrt der KVM-Extender automatisch die Eingabegerdte des konkurrierenden
Arbeitsplatzes. Die Sperre wird aufgehoben, wenn innerhalb der eingestellten Zeit-
spanne der Eingabesperre (Standard: 1 Sekunde) keine weitere Eingabe am aktiven
Arbeitsplatz erfolgt.

Nach der automatischen Aufhebung der Sperre ist die Bedienung des Rechners wie-
der an beiden Arbeitsplédtzen freigeschaltet.

Alternativ zur konkurrierenden Bedienung des Rechners durch die Arbeitsplédtze
kann die exklusive Bedienung (s. Seite 19) aktiviert werden.

Verwandte Themen:

= A:ndemng der Zeitspanne der Eingabesperre auf Seite 32
= Anderung der Videobetriebsart der Arbeitsplitze auf Seite 34

Exklusive Bedienung des KVM-Extenders

Um die exklusive Bedienung des KVM-Extenders durch einen Arbeitsplatz zu
ermoglichen, kann die Berechtigung fiir den exklusiven Zugriff des Arbeitsplatzes
aktiviert werden.

Ist diese Funktion eingeschaltet, kann die exklusive Bedienung des KVM-Extenders
mit der Tastenkombination Hotkey+Druck (Standard: Strg+Druck) aktiviert werden.
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Sofort nach Betdtigung dieser Tastenkombination sind die Eingabegerdte des kon-
kurrierenden Arbeitsplatzes deaktiviert. Durch erneutes Ausfithren der Tasten-
kombination am aktiven Arbeitsplatz, wird die Bedienung des KVM-Extenders
wieder fiir beide Arbeitsplatze freigeschaltet.

HINWEIS: Nach Aktivierung der exklusiven Bedienung des KVM-Extenders an
einem Arbeitsplatz blinken an der Tastatur des gesperrten Arbeitsplatzes abwech-
selnd die Caps Lock- und die Num- sowie Scroll Lock-LEDs.

Die exklusive Bedienung des KVM-Extenders wird am aktiven Arbeitsplatz durch
das Blinken der Scroll Lock-LED angezeigt.

TIPP: In der Standardkonfiguration des KVM-Extenders wird das Videosignal des
Rechners sowohl am Monitor des aktiven als auch am Monitor des konkurrieren-
den Arbeitsplatzes ausgegeben.

Andern Sie ggf. die Videobetriebsart der Arbeitsplatze (s. Seite 34), um das Bild
des konkurrierenden Arbeitsplatzes auszuschalten, wahrend Sie den Extender am
anderen Arbeitsplatz bedienen.

Verwandte Themen:

* Berechtigung fiir exklusiven Zugriff des Arbeitsplatzes auf Seite 33
= Anderung der Videobetriebsart der Arbeitsplitze auf Seite 34

= Anderung der Exklusiv-Taste auf Seite 31

Steckdose schalten

Durch die Verwendung eines kompatiblen Powerswitches (ePowerSwitch 1G R2, 4M+ R2
und 8M+ R2) haben Sie die Moglichkeit, die Stromversorgung von Geraten iiber den
KVM-Extender ein- und auszuschalten.

WICHTIG: Die Konfiguration der Powerswitches und die Zuordnung der Steckdo-
sen erfolgt ausschlieRlich in der Webapplikation Config Panel.

So schalten Sie die, dem KVM-Extender zugeordneten, Steckdose(n):
1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).

2. Wiébhlen Sie mit den Pfeiltasten die Zeile Target Power.

HINWEIS: Wenn dem Rechnermodul in der Webapplikation nicht mindestens
eine Steckdose zugewiesen ist, ist die Zeile nicht anwahlbar und der Text n.c.
(not connected) wird angezeigt.

3. Betdtigen Sie die Eingabetaste, um die in der Zeile angezeigt Operation auszufiihren:

turn off» Steckdose(n) ausschalten
turnon» Steckdose(n) einschalten
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Verwendung des Reset-Tasters

Zwischen der Identification-LED und den Power-LEDs auf der Frontseite des Rech-
ner- sowie des Arbeitsplatzmoduls ist der Reset-Taster platziert.

Mit diesem Taster ist sowohl die Wiederherstellung der Standardeinstellungen des
Moduls als auch die tempordre Deaktierung dessen Netzfilterregeln moglich.

HINWEIS: Um die versehentliche Betdtigung des Tasters zu vermeiden, ist dieser
hinter einer Bohrung in der Frontblende platziert.

Verwenden Sie einen diinnen und spitzen Gegenstand zur Betitigung des Tasters.

Wiederherstellung der Standardeinstellungen

Wird der Taster wahrend des Bootvorganges gedriickt und gehalten, werden die
Standardeinstellungen des Moduls wiederhergestellt.

HINWEIS: Fihren Sie diese Funktion am Arbeitsplatzmodul durch, werden die
Daten im lokalen OSD zuriickgesetzt. Bei Aufruf der Funktiom am Rechnermo-
dul werden die ab Seite 23 aufgefiihrten Standardeinstellungen des KVM-Exten-
ders wieder aktiv.

So stellen Sie die Standardeinstellungen wieder her:
1. Schalten Sie das Gerit aus, falls dieses derzeit in Betrieb ist.

2. Betdtigen Sie den Reset-Taster an der Frontseite des Gerdtes und halten Sie
diesen gedriickt.

3. Halten Sie den Taster weiterhin gedriickt und schalten Sie das Gerat ein.

4. Sobald die griine System-LED schnell blinkt, lassen Sie die Taste los.
HINWEIS: Die Wiederherstellung der Standardeinstellungen ist alternativ auch
uber das OSD oder die Webapplikation Config Panel moglich (s. Seite 48).

Nur bei der Wiederherstellung der Standardeinstellungen tiber die Webapplikation
ist optional die Beibehaltung der Konfiguration der Netzwerkschnittstellen moglich.
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Temporare Deaktivierung der Netzfilterregeln

Im Auslieferungszustand des KVM-Extenders haben alle Netzwerk-Rechner Zugriff
auf die IP-Adresse des Extenders (offener Systemzugang).

Uber die Webapplikation konnen Sie Netzfilterregeln erstellen, um den Zugang
zum Extender gezielt zu kontrollieren. Sobald eine Netzfilterregel erstellt ist, wird
der offene Systemzugang deaktiviert und alle eingehenden Datenpakete mit den
Netzfilterregeln verglichen.

Verhindern die aktuell eingestellten Netzfilterregeln den Zugang auf die Webappli-
kation, konnen Sie die Netzfilterregeln tempordr deaktivieren, um diese anschlie-
fend zu editieren.

So deaktivieren Sie die eingerichteten Netzfilterregeln temporir:

1. Schalten Sie das Gerit ein, falls dieses derzeit ausgeschaltet ist und warten Sie,
bis es betriebsbereit ist.

2. Betitigen Sie den Reser-Taster auf der Frontseite des Gerétes und halten Sie
diesen 5 Sekunden gedriickt.

‘ WICHTIG: Der offene Systemzugang ist jetzt aktiviert.

3. Bearbeiten Sie die im Gerdt gespeicherten Netzfilterregeln mit der Webapplika-
tion Config Panel und speichern Sie die Regeln anschliefend ab.

WICHTIG: Wird innerhalb von 15 Minuten keine neue Netzfilterkonfiguration
erstellt, werden die urspringlichen Einstellungen wieder aktiviert.
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Konfiguration

Die Konfiguration des KVM-Extenders kann wahlweise im On-Screen-Display
(OSD) oder iiber die Webapplikation Config Panel durch den Anwender gedndert
werden:

= Das On-Screen-Display wird auf dem Monitor des Arbeitsplatzes angezeigt. Die
meisten Konfigurationseinstellungen kdnnen Sie im OSD direkt am Arbeitsplatz
einstellen.

= Mit der Webapplikation Config Panel steht eine grafische Benutzeroberflache zur
Konfiguration und Uberwachung des KVM-Extenders iiber einen Webbrowser
zur Verfiigung.

Ubersicht der Funktionen und Standardeinstellungen

In der folgenden Tabelle finden Sie eine Ubersicht der konfigurierbaren Funktionen
des KVM-Extenders.Zusatzlich werden die Standardeinstellungen und Verweise auf

die ausfiithrlichen Erlduterungen der Funktionen aufgefiihrt.

Funktion Standardeinstellung Seite
Anderung des Hotkeys Strg 28
Anderung der 0SD-Taste Num 29
On-Screen-Display mit doppeltem Tastendruck starten ausgeschatet 30
Anderung der Exklusiv-Taste Druck 31
Anderung der Zeitspanne der Eingabesperre 1 Sekunde 32
Berechtigung fiir exklusiven Zugriff des Arbeitsplatzes erteilt 33
Anderung der Videobetriebsart der Arbeitsplitze immer an 34
Auswahl des EDID-Modus des KVM-Extenders auto 36
Reduzierung der Farbtiefe der zu iibertragenden Bilddaten 24 bit 37
Verwendung des Freeze-Modus deaktiviert 38
USB-HID-Modus auswahlen PC Standard 40
Unterstiitzung fiir Spezialtastaturen Standard 42
Anderung des Scancode-Sets einer PS/2-Tastatur Scancode-Set 2 43
Tastatur fiir Start des Arbeitsplatzmoduls erforderlich nein 45
Wartezeit des Bildschirmschoners einstellen deaktiviert 46
Tastaturlayout fiir Eingaben innerhalb des 0SDs auswéhlen  german 47
Wiederherstellung der Standardeinstellungen 48
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Funktion Standardeinstellung Seite
Farbe der Informationseinblendung dndern hellgriin 49
Anzeige der Informationseinblendung tempordr 50
Transparenz des On-Screen-Displays einstellen mittleres Durchscheinen 51
Position der Informationseinblendung é@ndern links oben 52
Position des On-Screen-Displays andern zentriert 52

Die grundlegende Bedienung des On-Screen-Displays (s. Seite 24) und der
Webapplikation Config Panel (s. Seite 26) wird auf den folgenden Seiten beschrieben.

Bedienung des On-Screen-Displays am Arbeitsplatz

Im On-Screen-Display (OSD) — wie auch tiber die im folgenden Abschnitt erlduterte
Webapplikation Config Panel — kann die Konfiguration des KVM-Extenders durch
den Anwender gedndert werden.

Der Aufruf des On-Screen-Displays ist am Arbeitsplatzmodul tiber die konfigurierte
Tastenkombination moglich. Die Einstellungen des KVM-Extenders konnen Sie
nur im entfernten OSD des Rechnermoduls einsehen und editieren.

HINWEIS: Sie konnen am Arbeitsplatz mit dem remote hotkey (Standard: Strg+Num)
das entfernte OSD des Rechnermodus und mit dem local hotkey (Standard:
Alt+Num) das lokale OSD des Arbeitsplatzmoduls aufrufen und konfigurieren.

Wahrend des Startvorgangs des Arbeitsplatzmoduls werden die Einstellungen bei-
der Hotkeys angezeigt (siehe Startvorgang auf Seite 10).

Anzeige des On-Screen-Displays am Arbeitsplatz

So starten Sie das On-Screen-Display:

1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).

Aufbau des On-Screen-Displays

Nach der Ausfithrung des Hotkeys wird das OSD auf dem Monitor des Arbeitsplat-
zes angezeigt:

Configuration Q)

Console setup

Local console setup e
Target setup e C)
System setup

Network setup

Information e
Target power turn off ()

ESC

Die Menitiansichten des On-Screen-Displays bestehen aus drei Hauptbereichen:
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Kopfzeile ®
Listenfeld @

FuBzeile ®

Hier wird der Titel des aktuellen Mentis angezeigt.

Im Listenfeld werden die Meniieintrdge des ausgewahlten Meniis
aufgefiihrt.

Zu unterscheiden sind zwei Arten von Meniieintrdgen:

= Meniipunkte mit Untermenii:

Diese Eintrage werden mit drei Punkten (...) in der rechten
Spalte dargestellt. Wéhlen Sie einen solchen Eintrag mit den
Pfeiltasten aus und betdtigen Sie die Eingabetaste, um das Unter-
meni zu 6ffnen.

= Meniipunkte okne Untermenii:
Die aktuelle Einstellung wird hinter dem Meniieintrag ange-
zeigt und kann direkt gedndert werden.

In der Fufizeile werden die wichtigsten Tasten zur Bedienung des
aktuell angezeigten Meniis und ggf. weitere Informationen aufge-
fithrt.

Bedienung des On-Screen-Displays

Das On-Screen-Display wird mit der Tastatur des Arbeitsplatzes bedient. Nachfol-
gend finden Sie eine Auflistung der hdufig verwendeten Tasten:

Pfeiltasten:

Eingabetaste:

Esc:

Tabulatortaste:

F2:

F8:

Strg+F8:

Mit den Pfeiltasten Hoch und Runter (in einigen Meniis auch
Links und Rechts) bewegen Sie die Positionsmarke zwischen
verschiedenen Menteintrdgen.

Diese Taste wird zur Bestatigung von Eingaben oder zum Aufruf
eines Untermentis verwendet.

Diese Taste schliefit die aktuell angezeigte Mentiansicht und
zeigt das iibergeordnete Menii an.

Falls Eingaben gedndert, aber nicht gespeichert wurden, erhal-
ten Sie diesbeziiglich eine Meldung.

Verwenden Sie diese Taste, um die Positionsmarke innerhalb
des Listenfeldes von einem Meniieintrag zum néchsten (oder
umgekehrt) zu bewegen.

Betatigen Sie diese Taste zur Speicherung Ihrer Eingaben.

Die aktuell angezeigte Meniiansicht wird nach der Speiche-
rung der Daten geschlossen und das iibergeordnete Meni
angezeigt.

Betétigen Sie diese Taste, um zwischen den verschiedenen
Optionen eines Meniieintrags zu wechseln.

Konfigurationseinstellungen mit vielen verfiigbaren Optionen
unterstiitzen diese Tastenkombination zum Aufruf einer iiber-
sichtlichen Liste aller Optionen.
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Grundlegende Bedienung der Webapplikation

Die Webapplikation Config Panel bietet eine grafische Benutzeroberfliche zur Konfigu-
ration und Uberwachung des KVM-Extenders.

Die Webapplikation verwendet die Java Web Start-Technologie. Diese Technologie
erlaubt die Ausfithrung der Java-Anwendung, unabhingig von den Einstellungen
und der Java-Kompatibilitdit des Webbrowsers.

HINWEIS: Grundlegende Informationen zu den Systemvoraussetzungen, der erfor-
derlichen Konfiguration der Netzwerkschnittstellen der DP-Vision-IP-Gerdte und
zum Einsatz der Webapplikation finden Sie im separaten Handbuch.

Start der Webapplikation

So starten Sie die Webapplikation Config Panel:
1. Geben in der Adresszeile folgende URL ein:
https://[IP-Adresse des Rechner- oder Arbeitsplatzmoduls]

2. Klicken Sie auf Download Config Panel.
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Benutzerauthentifizierung gegeniiber der Webapplikation
Nach der Bestétigung der Zertifikate wird die Login-Maske angezeigt.

So loggen Sie sich in die Webapplikation Config Panel ein:
1. Geben Sie in die Login-Maske folgende Daten ein:

Benutzername: Geben Sie Thren Benutzernamen ein.
Passwort: Geben Sie das Passwort Thres Benutzerkontos ein.
Sprachauswahl: Wihlen Sie die Sprache der Benutzeroberflache:

= (Default): Standardeinstellung anwenden

= English

= Deutsch

2. Klicken Sie auf Anmelden.

WICHTIG: Andern Sie das voreingestellte Passwort des Administratorkontos.

Melden Sie sich hierfiir mit dem Administratorkonto in die Webapplikation
ein und dndern Sie anschliefend das Passwort wie im separaten Handbuch der
‘Webapplikation beschrieben.

Die voreingestellten Zugangsdaten zum Administratorkonto lauten:

= Benutzername: Admin
= Passwort: 4658

27 - G&D DP-Vision-IP



Konfiguration

Konfigurationseinstellungen

Anderung des Hotkeys

Werden auf einem Rechner viele Anwendungsprogramme mit Tastenkombinatio-
nen bedient oder verschiedene KVM-Gerite in einer Kaskade verwendet, ist die
Zahl der ,freien” Tastenkombinationen moglicherweise eingeschrankt.

Falls ein Anwendungsprogramm oder ein anderes Gerat innerhalb der Kaskade den
gleichen Hotkey verwendet, kann dieser gedndert werden.

HINWEIS: Als Hotkey konnen Sie eine Taste oder eine Kombination aus den
Tasten Strg, Alt, Alt Gr, Win oder Shifi wahlen.

So dndern Sie den aktuellen Hotkey:

AW N
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. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
. Wiébhlen Sie die Zeile System setup und betétigen Sie die Eingabetaste.
. Wiébhlen Sie die Zeile Hotkey und betdtigen Sie die Eingabetaste.

. Wahlen Sie im Abschnitt Modifier mindestens eine der aufgefithrten Hotkey-

Modifizierertasten durch Markierung des entsprechenden Kontrollkést-
chens mit den Pfeiltasten und anschliefende Betédtigung der F8-Taste aus:

Cirl  » Strg-Taste (Standard)
Alt » Alt-Taste

Alt Gr » Alr GrTaste

Win » Windows-Taste

Shift » Umschalttaste

. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten

Anderungen.

. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].
. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-

Extenders.

3. Klicken Sie auf den Reiter Aligemein.

. Wahlen Sie in der Zeile Hotkey Modifizierer mindestens eine der aufgefithrten

Modifizierertasten (Strg, Alt, Alt Gr, Win oder Shiff) durch Anklicken des
bzw. der entsprechenden Kontrollkédstchen(s) aus.

. Klicken Sie auf OK, um die erfassten Daten zu speichern.
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Anderung der OSD-Taste

Der Hotkey zum OSD-Aufruf besteht aus mindestens einer Hotkey-Modifiziererta-
ste (sieche Anderung des Hotkeys auf Seite 28) und einer zusétzlichen OSD-Taste, die
vom Anwender innerhalb eines vorgegebenen Rahmens frei gewéhlt werden kann.

Sowohl die Hotkey-Modifizierertaste Strg als auch die OSD-Taste Num kénnen von
Thnen verandert werden.

So dndern Sie die aktuellen OSD-Taste:

1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
2. Wihlen Sie die Zeile System setup und betitigen Sie die Eingabetaste.
3. Waihlen Sie die Zeile Hotkey und betétigen Sie die Eingabetaste.

4. Waihlen Sie in der Zeile Key durch Betétigung der F8-Taste eine OSD-Taste
aus, welche gemeinsam mit der bzw. den Hotkey-Modifizierertaste(n) den
Aufruf des On-Screen-Displays bewirkt:

Num » Num-Taste (Standard)
Pause » Pause-Taste
Insert » Einfg-Taste

Delete » Entf-Taste
Home » Pos I-Taste
End » Ende-Taste
PgUp » Bild7-Taste
PgDn » Bid{-Taste
Space » Leertaste

5. Betétigen Sie die F2-Taste zur Speicherung der durchgefiihrten
Anderungen.

. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].

. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-
Extenders.

Config Panel

3. Klicken Sie auf den Reiter Aligemein.

. Wahlen Sie im Feld Hotkey die OSD-Taste aus, welche gemeinsam mit der
bzw. den Hotkey-Modifizierertaste(n) den Aufruf des On-Screen-Displays
bewirkt.

Zur Auswahl stehen die Tasten Pause, Einfg, Entf, Pos I, Bild auf, Bild ab,
Num, Ende oder Space.

. Klicken Sie auf OK, um die erfassten Daten zu speichern.
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On-Screen-Display mit doppeltem Tastendruck starten

Alternativ zum Offnen des On-Screen-Displays (OSD) mit der Tastenkombination
Hotkey+Num bzw. Doppel-Hotkey+Num konnen Sie das OSD durch die zweifache, auf-
einanderfolgende Betdtigung einer konfigurierten Taste 6ffnen.

So (de)aktivieren Sie die Aktivierung des On-Screen-Displays mit doppeltem
Tastendruck:

[
=
©
o
(=]
=
c
o
(8]

[V O R N I

. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
. Wiébhlen Sie die Zeile System setup und betétigen Sie die Eingabetaste.
. Wiébhlen Sie die Zeile Hotkey und betdtigen Sie die Eingabetaste.

. Wébhlen Sie in der Zeile 0SD via 2x keypress die gewiinschte Option aus:

0ff » OSD-Aufruf mit doppeltem Tastendruck deaktiviert (Standard)
Cirl » OSD-Aufruf mit doppeltem Druck auf die Strg-Taste

Alt » OSD-Aufruf mit doppeltem Druck auf die 4/+-Taste

AltGr » OSD-Aufruf mit doppeltem Druck auf die 4lf Gr-Taste

Win » OSD-Aufruf mit doppeltem Druck auf die Windows-Taste

Shift » OSD-Aufruf mit doppeltem Druck auf die Umschalt-Taste

Print » OSD-Aufruf mit doppeltem Druck auf die Druck-Taste

. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten

Anderungen.

. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].
. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-

Extenders.

. Klicken Sie auf den Reiter Allgemein.

. Wéhlen Sie im Feld 08D via doppeltem Tastendruck die gewtinschte Taste aus.
Aus » OSD-Aufruf mit doppeltem Tastendruck deaktiviert (Standard)
Strg OSD-Aufruf mit doppeltem Druck auf die Strg-Taste
Alt OSD-Aufruf mit doppeltem Druck auf die A/+-Taste

Win OSD-Aufruf mit doppeltem Druck auf die Windows-Taste
Shift OSD-Aufruf mit doppeltem Druck auf die Umschalt-Taste
Druck » OSD-Aufruf mit doppeltem Druck auf die Druck-Taste

»
Alt Gr » OSD-Aufruf mit doppeltem Druck auf die A/t Gr-Taste
»

. Klicken Sie auf OK, um die erfassten Daten zu speichern.
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Anderung der Exklusiv-Taste

Nach Betdtigung der Tastenkombination fiir die exklusive Bedienung des Extenders
sind die Eingabegerite des konkurrierenden Arbeitsplatzes deaktiviert. Erst durch
erneute Betédtigung der Tastenkombination am aktiven Arbeitsplatz, wird die Bedie-
nung des KVM-Extenders wieder fiir beide Arbeitsplatze freigeschaltet.

Die Tastenkombination fiir die exklusive Bedienung besteht aus mindestens einer
Hotkey-Modifizierertaste (siehe Anderung des Hotkeys auf Seite 28) und einer zusitzli-
chen Exklusiv-Taste, die vom Anwender innerhalb eines vorgegebenen Rahmens frei
gewdhlt werden kann. Sowohl die Hotkey-Modifizierertaste Strg als auch die Exklu-
siv-Taste Druck konnen von Thnen verdndert werden.

So dndern Sie die Exklusiv-Taste:

1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
2. Wibhlen Sie die Zeile System setup und betétigen Sie die Eingabetaste.
3. Waihlen Sie die Zeile Hotkey und betétigen Sie die Eingabetaste.

4. Waébhlen Sie in der Zeile Exclusive key durch Betétigung der F8-Taste die
Exklusiv-Taste aus:

Backspace » Riickschritt-Taste

Print v Druck-Taste (Standard)
Scroll » Rollen-Taste
Num » Num-Taste
Pause » Pause-Taste
Insert » Einfg-Taste
Delete » EntfTaste
Home » Pos I-Taste
End » Ende-Taste
PgUp » Bild7-Taste
PgDn » BildJ-Taste
Space v Leertaste

5. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten
Anderungen.

1. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].

2. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-
Extenders.
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3. Klicken Sie auf den Reiter Aligemein.
4. Wéhlen Sie im Feld Exklusivmodus-Aktionstaste die gewtinschte Taste aus.

Zur Auswahl stehen die Tasten Backspace, Druck, Rollen, Num, Pause, Einf.,
Entf, Pos 1, Ende, Bild T, BildJ und Space.

5. Klicken Sie auf 0K, um die erfassten Daten zu speichern.
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Anderung der Zeitspanne der Eingabesperre

Wird an einem Arbeitsplatz eine Eingabe per Tastatur oder Maus durchgefiihrt,
sperrt der KVM-Extender automatisch die Eingabegerdte des konkurrierenden
Arbeitsplatzes. Die Sperre wird aufgehoben, wenn innerhalb der eingestellten Zeit-
spanne der Eingabesperre (Standard: 1 Sekunde) keine weitere Eingabe am aktiven
Arbeitsplatz erfolgt.

Nach Ablauf der Zeitspanne der Eingabesperre ist die Bedienung des Rechners wie-
der an beiden Arbeitsplédtzen freigeschaltet.

Die Zeitspanne der Eingabesperre kann durch den Anwender innerhalb des
Bereichs von 1 bis 90 Sekunden eingestellt werden.

So dndern Sie die Zeitspanne der Eingabesperre:

1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
2. Wiébhlen Sie die Zeile System setup und betétigen Sie die Eingabetaste.

3. Geben Sie im Feld Multiuser input lock die gewtiinschte Zeitspanne der
Eingabesperre (1 bis 90 Sekunden) ein.

4. Betdtigen Sie die F2-Taste zur Speicherung der durchgefiihrten
Anderungen.

1. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].

2. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-
Extenders.
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3. Klicken Sie auf den Reiter Allgemein.

4. Geben Sie im Feld Multiuser-Eingabesperre die gewiinschte Zeitspanne der
Eingabesperre (1 bis 90 Sekunden) ein.

5. Klicken Sie auf 0K, um die erfassten Daten zu speichern.

Verwandtes Thema:
= Exklusive Bedienung des KVM-Extenders auf Seite 19
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Berechtigung fiir exklusiven Zugriff des Arbeitsplatzes

Erfolgt innerhalb der eingestellten Zeitspanne der automatischen Eingabesperre
(Standard: 1 Sekunde) keine Eingabe am aktiven Arbeitsplatz, erlaubt der KVM-
Extender in der Standardeinstellung auch dem anderen Arbeitsplatz die Bedienung
des Extenders.

Wird die Berechtigung fiir exklusiven Zugriff des Arbeitsplatzes in der Webapplika-
tion eingeschaltet, konnen Anwender an einem solchen Arbeitsplatz mit der Tasten-
kombination Hotkey+Druck (Vorgabe: Strg+Druck) die exklusive Bedienung des
KVM-Extenders erreichen.

Nach Betidtigung dieser Tastenkombination werden die Eingabegerate des konkur-
rierenden Arbeitsplatzes deaktiviert. Durch erneutes Ausfithren der Tastenkombina-
tion am aktiven Arbeitsplatz, wird die Bedienung des KVM-Extenders wieder fiir
beide Arbeitsplatze freigeschaltet.

HINWEIS: Nach Aktivierung der exklusiven Bedienung des KVM-Extenders an
einem Arbeitsplatz blinken an der Tastatur des gesperrten Arbeitsplatzes abwech-
selnd die Caps Lock- und die Num- sowie Scroll Lock-LEDs.

Die exklusive Bedienung des KVM-Extenders wird am aktiven Arbeitsplatz durch
das Blinken der Scroll Lock-LED angezeigt.

So wihlen Sie die Berechtigung fiir exklusiven Zugriff eines Arbeitsplatzes:

1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).

2. Wibhlen Sie die Zeile Console setup und betitigen Sie die Eingabetaste, falls
Sie die Berechtigung fiir den entfernten Arbeitsplatz (am CON-Modul)
einstellen mochten.

‘Wahlen Sie die Zeile Local console setup und betdtigen Sie die Eingabetaste,
falls Sie die Berechtigung fiir den lokalen Arbeitsplatz (am CPU-Modul)
einstellen mochten.

3. Wahlen Sie in der Zeile Enable exclusive durch Betédtigung der F8-Taste zwi-
schen folgenden Optionen:

yes» Berechtigung fiir exklusiven Zugriff erteilt (Standard)
no » Berechtigung fiir exklusiven Zugriff verweigert

4. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten
Anderungen.
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1. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].

2. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-
Extenders.
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3. Klicken Sie auf den Reiter Lokal, falls Sie die Berechtigung fiir den lokalen
Arbeitsplatz (am CPU-Modul) einstellen mochten.

Klicken Sie auf den Reiter Remote > Allgemein, falls Sie die Berechtigung fiir
den entfernten Arbeitsplatz (am CON-Modul) einstellen mochten.

4. Wihlen Sie im Feld Permanent-Access-Modus zwischen folgenden Optionen:

Aktiviert » Berechtigung fiir exklusiven Zugriff erteilt (Standard)
Deaktiviert » Berechtigung fiir exklusiven Zugriff verweigert

5. Klicken Sie auf 0K, um die erfassten Daten zu speichern.

Verwandte Themen:

= Exklusive Bedienung des KV M-Extenders auf Seite 19
= Anderung der Videobetriebsart der Arbeitsplitze auf Seite 34

Anderung der Videobetriebsart der Arbeitsplatze

In der Standardkonfiguration des KVM-Extenders wird das Bild des Rechners
sowohl am Monitor des aktiven als auch am Monitor des konkurrierenden Arbeits-
platzes ausgegeben.

Alternativ konnen Sie festlegen, dass das Bild des anderen Arbeitsplatzes ausge-
schaltet wird, sobald eine Eingabe an einem Arbeitsplatz erfolgt.

Das Bild wird auf dem anderen Arbeitsplatz wird angezeigt, sobald die Eingaben
des Anwenders am Arbeitsplatz abgeschlossen sind.
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So wihlen Sie die Videobetriebsart eines Arbeitsplatzes:

1.
2.

Config Panel

Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).

Wiéhlen Sie die Zeile Console setup und betétigen Sie die Eingabetaste, falls
Sie die Videobetriebsart des entfernten Arbeitsplatzes (am CON-Modul)
einstellen mochten.

Wihlen Sie die Zeile Local console setup und betétigen Sie die Eingabetaste,
falls Sie die Videobetriebsart des lokalen Arbeitsplatzen (am CPU-Modul)
einstellen mochten.

. Wihlen Sie in der Zeile Video mode durch Betétigung der F8-Taste zwischen

folgenden Optionen:

always on » Bild immer an (Standard)
switch off » Bild bei Aktionen am anderen Arbeitsplatz ausschalten

. Betétigen Sie die F2-Taste zur Speicherung der durchgefiihrten

Anderungen.

. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].
. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-

Extenders.

. Klicken Sie auf den Reiter Lokal, falls Sie die Videobetriebsart des lokalen

Arbeitsplatz (am CPU-Modul) einstellen mochten.

Klicken Sie auf den Reiter Remote > Allgemein, falls Sie die Videobetriebsart
des entfernten Arbeitsplatz (am CON-Modul) einstellen mochten.

. Wihlen Sie im Feld Bildanzeige zwischen folgenden Optionen:

» immer an (Standard)
» bei Aktionen am entfernten/lokalen Arbeitsplatz aus

. Klicken Sie auf OK, um die erfassten Daten zu speichern.

Verwandte Themen:

= Anderung der Zeitspanne der Eingabesperre auf Seite 32
= Berechtigung fiir exklusiven Zugriff des Arbeitsplatzes auf Seite 33
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Auswahl des EDID-Modus des KVM-Extenders

Die EDID-Informationen (Extended Display Identification Data) eines Monitors infor-
mieren die Grafikkarte des angeschlossenen Rechners u. a. iiber verschiedene techni-
sche Eigenschaften des Gerdtes. Die Informationen werden vom KVM-Extender
tiblicherweise unverdndert iber Enhanced-DDC (Enhanced Display Data Channel) an
den Rechner weitergeleitet.

HINWEIS: Beachten Sie bei der Erstinbetriebnahme sowie bei Anschluss eines
anderen Monitors die auf Seite 10 empfohlene Einschaltreihenfolge.

Fiir bestimmte Auflosungen werden spezielle GUD-Profile mitgeliefert. Die Namen
dieser Profile geben Auskunft tiber die bevorzugte Auflésung, die bei Anwendung
des Profils an die Grafikkarte des Rechners iibermittelt wird.

Alternativ kann in der Webapplikation Config Panel das EDID-Profil eines Monito-
res eingelesen und durch den KVM-Extender an den angeschlossenen Rechner
ibermittelt werden. Ausfiihrliche Informationen hierzu finden Sie im separaten
Handbuch zur Webapplikation Config Panel.

So wihlen Sie den EDID-Modus des KVM-Extenders:

1.
2.
3.

Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
‘Waihlen Sie die Zeile Target setup und betdtigen Sie die Eingabetaste.

Wahlen Sie in der Zeile EDID mode durch Betétigung der F8-Taste zwischen
folgenden Optionen:

auto » automatische Behandlung der EDID-Daten (Standard)
user » Verwendung eines G&D-Profils oder eines vom
Benutzer in der Webapplikation eingelesenen Profils

. Falls Sie die Option user gewéhlt haben, wéhlen Sie die Zeile Assign EDID und

betétigen Sie die Eingabetaste.

Wahlen Sie mit den Pfeiltasien das zu aktivierende Profil und aktivieren Sie
es mit der F8-Taste. Speichern Sie Ihre Auswahl mit der F2-Taste.

. Betitigen Sie die F2-Taste zur Speicherung der durchgefithrten

Anderungen.
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1. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].

2. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-
Extenders.

Config Panel

3. Klicken Sie auf den Reiter Allgemein.

4. Waéhlen Sie im Feld Edid-Profil zwischen folgenden Optionen:

[Auto] » automatische Behandlung der EDID-Daten (Standard)
GUD DVI.... » von G&D erstelltes Profil fiir eine bestimmte Auflosung
Name » vom Benutzer eingelesenes EDID-Profil

5. Klicken Sie auf 0K, um die erfassten Daten zu speichern.

Reduzierung der Farbtiefe der zu iibertragenden Bilddaten

In der Standardeinstellung des KVM-Extenders werden die Bildinformationen mit

einer maximalen Farbtiefe von 24 bit an das Arbeitsplatzmodul iibertragen.

Bei Verwendung einer hohen Bildauflésung und Darstellung von Bewegtbildern
kann es in Ausnahmefillen vorkommen, dass einige Bilder am Arbeitsplatzmodul

,,ubersprungen“ werden.

Reduzieren Sie in einem solchen Fall die zu iibertragende Farbtiefe der Bilddaten

auf 18 bit. Hierdurch kann die zu tibertragende Datenmenge reduziert werden.

HINWEIS: Abhangig vom Bildinhalt konnen gegebenenfalls leichte Farbstufen bei

Reduzierung der Farbtiefe erkennbar werden.

So dndern Sie die Farbtiefe der zu iibertragenden Bilddaten:

1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).

2. Wihlen Sie die Zeile Target setup und betatigen Sie die Eingabetaste.

3. Wihlen Sie in der Zeile Color depth durch Betdtigung der F8-Taste zwischen

folgenden Optionen:

24 bit » Ubertragung der Bilddaten mit einer maximalen Farbtiefe
von 24 bit (Standard)
18 bit » Reduzierung der Farbtiefe der Bilddaten auf 18 bit

4. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten
Anderungen.

37 - G&D DP-Vision-IP



Konfiguration

1. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].

2. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-
Extenders.
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3. Klicken Sie auf den Reiter Aligemein.
4. Wihlen Sie im Feld Farbtiefe zwischen folgenden Optionen:

24 bit » Ubertragung der Bilddaten mit einer maximalen Farbtiefe
von 24 bit (Standard)
18 bit » Reduzierung der Farbtiefe der Bilddaten auf 18 bit

5. Klicken Sie auf 0K, um die erfassten Daten zu speichern.

Verwendung des Freeze-Modus

Wird die Kabelverbindung zwischen dem Rechner- und dem Arbeitsplatzmodul im
laufenden Betrieb unterbrochen, wird in der Standardeinstellung des KVM-Extenders
kein Bild auf dem Monitor des entfernten Arbeitsplatzes dargestellt.

Aktivieren Sie den Freeze-Modus, wenn Sie im Falle eines Verbindungsabbruchs das
zuletzt am Arbeitsplatzmodul empfangene Bild darstellen mochten bis die Verbin-
dung wiederhergestellt ist.

Um den Verbindungsabbruch deutlich zu signalisieren, wird das zuletzt empfan-
gene Bild wahlweise mit einem farbigen Rahmen und/oder der Einblendung Frozen
und der vergangenen Zeit seit dem Verbindungsabbruch dargestellt.

So konfigurieren Sie den Freeze-Modus:

1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
2. Wibhlen Sie die Zeile Console setup und betétigen Sie die Eingabetaste.

3. Wiéhlen Sie in der Zeile Freeze mode durch Betatigung der F8-Taste zwi-
schen folgenden Optionen:

off » Freeze-Modus deaktiviert (Standard)
on » Freeze-Modus aktiviert

4. Falls der Freeze-Modus aktiviert ist, wahlen Sie in der Zeile Freeze visualization
durch Betétigung der F8-Taste zwischen folgenden Optionen:

frame » Anzeige eines farbigen Rahmens bei Verbindungsabbruch

0SD » Einblendung des Hinweises Frozen und der vergangenen Zeit
seit dem Verbindungsabbruch

frame+0SD » Anzeige des farbigen Rahmens (frame) und Einblendung des
Hinweises Frozen (0SD)

5. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten
Anderungen.
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1. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].

2. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-
Extenders.

Config Panel

3. Klicken Sie auf die Reiter Remote > Allgemein.

4. Wiéhlen Sie im Feld Freeze-Modus zwischen folgenden Optionen (s. oben):

Deaktiviert (Standard)
Aktiviert

5. Falls der Freeze-Modus aktiviert ist, wihlen Sie zusatzlich eine oder beide
Optionen im Feld Freeze-Visualisierung:

Rahmen » Anzeige eines farbigen Rahmens bei Verbindungsabbruch.
0sD » Einblendung des Hinweises Frozen und der vergangenen Zeit
seit dem Verbindungsabbruch.

6. Klicken Sie auf 0K, um die erfassten Daten zu speichern.
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USB-HID-Modus auswahlen

Der KVM-Extender unterstiitzt verschiedene USB-Eingabegerite. Die besonderen
Eigenschaften eines bestimmten USB-Eingabegerites konnen Sie nach Auswahl des
spezifischen USB-Tastaturmodus nutzen.

Alternativ zu den spezifischen USB-Tastaturmodi konnen Sie den Generic-HID-
Modus nutzen. In diesem Modus werden die Daten des USB-Gerétes an der ober-
sten Keyh./Mouse-Buchse des Arbeitsplatzmoduls unverdandert an das Rechnermodul
tbertragen.

WICHTIG: Der Generic-HID-Modus unterstiitzt viele der am Markt erhéltlichen
HID-Geriéte. Der Betrieb eines bestimmten HID-Gerétes im Generic-HID-Modus
kann nicht gewahrleistet werden.

WICHTIG: Bei Anschluss eines USB-Hubs oder USB-Verbundgerites mit mehre-
ren USB-Geréten kann nur das erste der angeschlossenen HID-Geréte im Generic-
HID-Modus verwendet werden.

= USB-Tastaturen: Im voreingestellten USB-Tastaturmodus PC Standard werden die
Tasten des Standard-Tastaturlayouts unterstiitzt.

Bei Einsatz eines Apple Keyboards bzw. Sun Keyboards erlauben spezielle Tastaturmodi
die Verwendung der Sondertasten dieser Tastaturen.

Die folgende Tabelle listet die unterstiitzten USB-Tastaturen auf:

EINGABEGERAT EINSTELLUNG
PC-Tastatur mit Standard-Tastaturlayout » PC Standard
PC-Tastatur mit zusdtzlichen Multimedia-Tasten » Multimedia
Apple Keyboard mit Ziffernblock (A1243) » Apple A1243
Sun Keyboard (deutsches Tastaturlayout) » SUN DE

Sun Keyboard (amerikanisches Tastaturlayout) » SUN US

= Displays und Tablets: Sie konnen den am KVM-Extender angeschlossenen Rechner
mit einem der unterstiitzten Displays oder Tablets bedienen:

EINGABEGERAT EINSTELLUNG

HP 2310tk » HP 2310t

ilyama 71931 » iiyama 71931
NOTTROT N170 KGE » NOTTROT N170 KGE
Pixelpower » Pixelpower

Wacom Cintiq 21UX » Wacom Cint.21

Wacom Intuos3

» Wacom Int.3

Wacom Intuos4 S » Wacom Int.4S
Wacom Intuos4 M » Wacom Int.4M
Wacom Intuos4 L » Wacom Int.4L
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EINGABEGERAT

EINSTELLUNG

Wacom Intuos4 XL

» Wacom Int.4XL

Wacom Intuos5 S

» Wacom Int.5S

Wacom Intuos5 M
Wacom Intuos5 L

» Wacom Int.5M
» Wacom Int.5L

= Generic-HID-Modus: In diesem Modus werden die Daten des USB-Gerdtes an der
obersten Keyb./Mouse-Buchse des Arbeitsplatzmoduls unverdndert an das Rechner-
modul ibertragen.

EINGABEGERAT EINSTELLUNG

beliebiges USB-Gerat » Generic HID

WICHTIG: Der Generic-HID-Modus unterstiitzt viele der am Markt erhiltlichen
HID-Gerite. Der Betrieb eines bestimmten HID-Geradtes im Generic-HID-Modus
kann nicht gewidhrleistet werden.

= Controller: Der Multimedia-Controller ShuttlePRO v2 wird zur Bedienung verschie-
dener Audio- und Videoprogramme genutzt. Ein spezieller USB-Tastaturmodus
erlaubt die Verwendung des Controllers zur Bedienung des am Target-Moduls ange-
schlossenen Rechners:

EINGABEGERAT EINSTELLUNG
Contour ShuttlePRO v2 » Contour SP2

= LK463-kompatible Tastatur: An das Arbeitsplatzmodul kénnen Sie eine LK463-kom-
patible Tastatur anschliefen. Die Anordnung der 108 Tasten solcher Tastaturen ent-
spricht dem OpenVMS-Tastaturlayout.

Ein spezieller USB-Tastaturmodus gewahrleistet die Ubermittlung der Betdtigung
einer Sondertaste dieser Tastatur an den Zielrechner:

EINGABEGERAT EINSTELLUNG
LK463-kompatible Tastatur » LK463
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So wihlen Sie einen USB-HID-Modus:

1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
2. Wihlen Sie die Zeile Target setup und betdtigen Sie die Eingabetaste.

3. Wiéhlen Sie die Zeile USB HID mode und betitigen Sie die F8-Taste zur Aus-
wahl einer Option (s. oben).

4. Betdtigen Sie die F2-Taste zur Speicherung der durchgefiihrten
Anderungen.

. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].

. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-
Extenders.

T
c
©

o

=

=

c
o

(8]

. Klicken Sie auf den Reiter Aligemein.
. Wihlen Sie im Feld USB-HID-Mode die gewiinschte Option (s. oben).

. Klicken Sie auf OK, um die erfassten Daten zu speichern.

Unterstiitzung fiir Spezialtastaturen
Der KVM-Extender unterstiitzt die Sonderfunktionen einiger Spezialtastaturen.

Aktivieren Sie die Unterstiitzung einer solchen Tastatur, falls Sie diese am Arbeits-
platz einsetzen mochten.

So schalten Sie die Unterstiitzung fiir Spezialtastaturen an oder aus:

1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).

2. Wihlen Sie die Zeile Console setup und betitigen Sie die Eingabetaste, falls
Sie die Unterstiitzung einer Spezialtastatur fiir den entfernten Arbeitsplatz
(am CON-Modul) einstellen mochten.

Waihlen Sie die Zeile Local console setup und betétigen Sie die Eingabetaste,
falls Sie die Unterstiitzung einer Spezialtastatur fiir den lokalen Arbeits-
platz (am CPU-Modul) einstellen m&chten.

3. Wahlen Sie in der Zeile Enh. keyboard durch Betédtigung der F8-Taste zwi-
schen folgenden Optionen:

no » Unterstiitzung von Spezialtastaturen deaktivieren
PixelPower C » Unterstiitzung der Tastatur PixelPower Blue aktivieren
SKIDATA1 » Unterstiitzung der Tastatur SKIDATAI aktivieren

4. Betdtigen Sie die F2-Taste zur Speicherung der durchgefiihrten
Anderungen.
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Config Panel

1. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].
2. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-

Extenders.

. Klicken Sie auf den Reiter Lokal, falls Sie die Unterstiitzung einer Spezialta-

statur fiir den lokalen Arbeitsplatz (am CPU-Modul) einstellen mochten.

Klicken Sie auf den Reiter Remote > Allgemein, falls Sie die Unterstiitzung
einer Spezialtastatur fiir den entfernten Arbeitsplatz (am CON-Modul) ein-
stellen mochten.

. Wihlen Sie im Feld PS/2-Tastaturtyp zwischen folgenden Optionen:

Standard » Unterstiitzung von Spezialtastaturen deaktivieren
PixelPower Blue » Unterstiitzung der Tastatur Pixe/Power Blue aktivieren
SKIDATA1 » Unterstiitzung der Tastatur SKIDATAI aktivieren

5. Klicken Sie auf 0K, um die erfassten Daten zu speichern.

Anderung des Scancode-Sets einer PS/2-Tastatur

Wird eine Taste der PS/2-Tastatur gedriickt, sendet der Tastaturprozessor ein
Datenpaket, das als Scancode bezeichnet wird. Es gibt zwei gebrauchliche Scan-
code-Sets (Sets 2 und 3), die verschiedene Scancodes beinhalten.

Der KVM-Extender interpretiert in der Standardeinstellung alle Eingaben einer PS/2-
Tastatur mit dem Scancode-Set 2.

Falls das Verkettungszeichen (engl. Pipe, ,,|”) nicht eingegeben werden kann oder
die Pfeiltasten der Tastatur nicht wie erwartet funktionieren, ist die Umstellung auf
das Scancode-Set 3 empfehlenswert.
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So dndern Sie die Einstellung des Scancode-Sets:

Config Panel

. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).

. Wiéhlen Sie die Zeile Console setup und betatigen Sie die Eingabetaste, falls

Sie das Scancode-Set fiir den entfernten Arbeitsplatz (am CON-Modul) ein-
stellen mochten.

Wihlen Sie die Zeile Local console setup und betétigen Sie die Eingabetaste,
falls Sie das Scancode-Set fiir den lokalen Arbeitsplatz (am CPU-Modul)
einstellen mochten.

. Wihlen Sie in der Zeile Scancode set durch Betatigung der F8-Taste zwi-

schen folgenden Optionen:

2 » Aktivierung des Scancode-Sets 2 fiir PS/2-Tastatureingaben
3 » Aktivierung des Scancode-Sets 3 fiir PS/2-Tastatureingaben

. Betétigen Sie die F2-Taste zur Speicherung der durchgefiihrten

Anderungen.

Die Tastatur wird nach dem erneuten Einschalten initialisiert und das ausgewdhlite
Scancode-Set angewendet.

. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].
. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-

Extenders.

. Klicken Sie auf den Reiter Lokal, falls Sie die das Scancode-Set fiir den

lokalen Arbeitsplatz (am CPU-Modul) einstellen mochten.

Klicken Sie auf den Reiter Remote > Allgemein, falls Sie das Scancode-Set
fiir den entfernten Arbeitsplatz (am CON-Modul) einstellen mochten.

. Wibhlen Sie im Feld Scancode Set zwischen folgenden Optionen:

Set2» Aktivierung des Scancode-Sets 2 fiir PS/2-Tastatureingaben
Set3» Aktivierung des Scancode-Sets 3 fiir PS/2-Tastatureingaben

. Klicken Sie auf OK, um die erfassten Daten zu speichern.

. Schalten Sie den KVM-Extender aus und wieder ein.

Die Tastatur wird nach dem erneuten Einschalten initialisiert und das ausgewdhlite
Scancode-Set angewendet.
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Tastatur fir Start des Arbeitsplatzmoduls erforderlich

In der Standardeinstellung startet das Arbeitsplatzmodul auch bei fehlender Tasta-
tur. Alternativ kann das Arbeitsplatzmodul den Startvorgang bei fehlender Tastatur
mit einem entsprechenden Hinweis unterbrechen. Sobald Sie eine Tastatur an das
Arbeitsplatzmodul anschliefen, wird der Startvorgang fortgesetzt.

So konfigurieren Sie das Startverhalten bei fehlender Tastatur des Arbeitsplatz-
moduls:

1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
2. Wihlen Sie die Zeile Console setup und betatigen Sie die Eingabetaste.

3. Waihlen Sie in der Zeile Keyboard required durch Betétigung der F8-Taste
zwischen folgenden Optionen:

no » Startvorgang bei Fehlen der Tastatur fortsetzen (Standard).
yes » Startvorgang bei Fehlen der Tastatur unterbrechen.

4. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten
Anderungen.

. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].

. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-
Extenders.
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Klicken Sie auf den Reiter Remote > Allgemein.
. Wihlen Sie im Feld Tastatur erforderlich zwischen folgenden Optionen:

Nein » Startvorgang bei Fehlen der Tastatur fortsetzen (Standard).
Ja » Startvorgang bei Fehlen der Tastatur unterbrechen.

. Klicken Sie auf OK, um die erfassten Daten zu speichern.
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Wartezeit des Bildschirmschoners einstellen

Der Bildschirmschoner schaltet nach einer von Ihnen einstellbaren Zeit der Inaktivi-
tit des Benutzers die Bildschirmanzeige am Arbeitsplatz ab.

HINWEIS: Diese Einstellung ist unabhingig von den Bildschirmschoner-Einstel-
lungen des am Rechnermodul angeschlossenen Rechners.

So stellen Sie die Wartezeit des Bildschirmschoners ein:

1.
2.
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Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).

Wihlen Sie die Zeile Console setup und betétigen Sie die Eingabetaste, falls
Sie den Bildschirmschoner des entfernten Arbeitsplatzes (am CON-Modul)
einstellen mochten.

Wihlen Sie die Zeile Local console setup und betétigen Sie die Eingabetaste,
falls Sie den Bildschirmschoner des lokalen Arbeitsplatzes (am CPU-Modul)
einstellen mochten.

. Geben Sie in der Zeile Screensaver (min) die Wartezeit (1 bis 999 Minuten)

des Bildschirmschoners ein.

Der Wert 0 deaktiviert den Bildschirmschoner.

. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten

Anderungen.

. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].
. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-

Extenders.

. Klicken Sie auf den Reiter Lokal, falls Sie den Bildschirmschoner des

lokalen Arbeitsplatzes (am CPU-Modul) einstellen mochten.

Klicken Sie auf den Reiter Remote > Allgemein, falls Sie den Bildschirmscho-
ner des entfernten Arbeitsplatzes (am CON-Modul) einstellen mochten.

. Geben Sie in der Zeile Bildschirmschoner (Minuten) die Wartezeit (1 bis

999 Minuten) des Bildschirmschoners ein.

Der Wert 0 deaktiviert den Bildschirmschoner.

. Klicken Sie auf OK, um die erfassten Daten zu speichern.
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Tastaturlayout fiir Eingaben innerhalb des OSDs auswahlen

Werden bei der Eingabe von Zeichen auf der Tastatur des Arbeitsplatzes andere
Zeichen im On-Screen-Display angezeigt, ist das eingestellte Tastaturlayout der
Tastatur nicht zutreffend.

Stellen Sie in diesem Fall fest, welchem Tastaturlayout die angeschlossene Tastatur
entspricht und konfigurieren Sie dieses anschliefend in den Einstellungen des
Arbeitsplatzmoduls.

So wihlen Sie das Tastaturlayout der Tastatur des Arbeitsplatzmoduls aus:

1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
2. Wibhlen Sie die Zeile Console setup und betétigen Sie die Eingabetaste.

3. Wihlen Sie in der Zeile 08D key. layout durch Betdtigung der F8-Taste zwi-
schen folgenden Optionen:

» german
» english US
» english UK
» french

» spanish

» lat. americ.
» portuguese

4. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten
Anderungen.

1. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].

2. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-
Extenders.
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3. Klicken Sie auf die Reiter Remote > Allgemein.
4. Wiébhlen Sie im Feld Tastaturlayout zwischen folgenden Optionen:

» Deutsch

» Englisch (USA)

» Englisch (GroBbritannien)
» Franzdsisch

» Spanisch

» lat. Amerikanisch

» Portugiesisch

5. Klicken Sie auf 0K, um die erfassten Daten zu speichern.
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Wiederherstellung der Standardeinstellungen

HINWEIS: Diese Funktion kann ausschlieflich tiber die Webapplikation ausge-
fithrt werden.

Mit dieser Funktion werden die Standardeinstellungen des KVM-Extenders wieder-
hergestellt. Nach dem Ausfithren der Funktion sind die auf Seite 23 aufgefiihrten
Standardeinstellungen des KVM-Extenders wieder aktiv.

So stellen Sie die Standardeinstellungen wieder her:

HINWEIS: Offnen Sie das lokale OSD des Arbeitsplatzmoduls mit dem local hotkey
(Standard: Alt+Num), falls Sie statt den Einstellungen des Extender-Systems nur
die lokalen Einstellungen des Arbeitsplatzmodul zuriicksetzen mochten.

1. Starten Sie das entfernte OSD des Rechnermoduls mit dem remote hotkey
(Standard: Strg+Num), falls Sie die Einstellungen des Extender-Systems
zuriicksetzen mochten.

Offnen Sie das lokale OSD des Arbeitsplatzmoduls mit dem local hotkey
(Standard: Alt+Num), falls Sie nur die lokalen Einstellungen des Arbeits-
platzmodul zuriicksetzen mochten.

2. Wihlen Sie die Zeile System setup (entferntes OSD) bzw. Console utility
(lokales OSD) und betitigen Sie die Eingabetaste.

3. Wihlen Sie die Zeile Set system defauts und betétigen Sie die Eingabetaste.

4. Bestdtigen Sie die Sicherheitsabfrage oder brechen Sie den Vorgang ab.

. Klicken Sie in der Symbolleiste auf das Werkzeugsymbol.
. Klicken Sie auf die Reiter Werkzeuge > Werkseinstellungen.

Prijfen Sie anhand der Informationen der Felder »Gerdt« und »Kommentar« des
Dialogs, ob es sich um das gewiinschte Gerdt handelt!
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. Deaktivieren Sie ggf. die Option Netzwerkkonfiguration léschen, falls Sie die
Konfiguration der Netzwerkschnittstellen beibehalten mdchten.

. Klicken Sie auf die Schaltfliche Werkseinstellungen, um die Standardeinstel-
lungen wiederherzustellen.

HINWEIS: Die Wiederherstellung der Standardeinstellungen ist alternativ auch
durch Betétigung des Reser-Tasters moglich.

Weitere Informationen hierzu finden Sie auf Seite 21.
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Farbe der Informationseinblendung andern

Informationseinblendungen werden standardmafig in hellgriin angezeigt. Im per-
sonlichen Profil konnen Sie die Farbe dieser Einblendungen anpassen.

Neben der Standardfarbe light green (hellgriin) werden folgende Farben unterstiitzt:

black (schwarz) dark red (dunkelrot)
green (griin) dark yellow (dunkelgelb)
dark blue (dunkelblau) purple (violett)

dark turquoise (dunkeltiirkis) silver (silber)

yellow (gelb) blue (blau)

fuchsia (magenta) light turquoise (helltiirkis)
white (weif)

So dndern Sie die Einstellung der Informationseinblendung:

1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
2. Wihlen Sie die Zeile Console setup und betétigen Sie die Eingabetaste.

3. Wihlen Sie die Zeile Personal Pprofile und betitigen Sie die Eingabetaste.

4

. Wihlen Sie in der Zeile Display color durch Betédtigung der F8-Taste die
gewlinschte Farbe.

5. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten
Anderungen.

1. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].

2. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-
Extenders.

Config Panel

3. Klicken Sie auf die Reiter Remote > Extendersysteme > Persénliches Profil.
4. Wiébhlen Sie im Feld Display-Farbe die gewiinschte Farbe.

5. Klicken Sie auf 0K, um die erfassten Daten zu speichern.
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Anzeige der Informationseinblendung

Informationseinblendungen erfolgen temporar (5 Sekunden) in der linken, oberen

Ecke.

TIPP:

Ist die tempordre Informationseinblendung aktiv, kénnen Sie mit der

Tastenkombination Strg+Feststelltaste jederzeit eine Wiederholung der Einblen-
dung erreichen.

Alternativ zur temporiren Einblendung kann die Informationseinblendung perma-
nent erfolgen oder ausgeschaltet werden.

So dndern Sie die Einstellung der Informationseinblendung:
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1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
2. Wiébhlen Sie die Zeile Console setup und betétigen Sie die Eingabetaste.

3.
4

‘Wihlen Sie die Zeile Personal Profile und betitigen Sie die Eingahetaste.

. Wahlen Sie in der Zeile Display durch Betdtigung der F8-Taste zwischen

folgenden Optionen:

Aus » Informationseinblendung ausschalten
Tempordr » tempordre Informationseinblendung fiir 5 Sekunden (Standard)
Permanent» permanente Informationseinblendung

. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten

Anderungen.

. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].

. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-

Extenders.

3. Klicken Sie auf die Reiter Remote > Extendersysteme > Personliches Profil.

. Wahlen Sie im Feld Display zwischen folgenden Optionen:

Aus » Informationseinblendung ausschalten
Tempordr » tempordre Informationseinblendung fiir 5 Sekunden (Standard)
Permanent» permanente Informationseinblendung

. Klicken Sie auf OK, um die erfassten Daten zu speichern.
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Transparenz des On-Screen-Displays einstellen

In der Standardeinstellung wird das On-Screen-Display (OSD) mit einer mittleren
Transparenz iiber dem Bildschirminhalt angezeigt. Den durch das OSD iiberlager-
ten Teil des Bildschirminhalts konnen Sie ,,durch* das OSD erkennen.

Die Transparenzstufe konnen Sie einstellen oder ausschalten.
So stellen Sie die Transparenzstufe des On-Screen-Displays ein:

1. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
2. Wihlen Sie die Zeile Console setup und betétigen Sie die Eingabetaste.

3. Wihlen Sie die Zeile Personal Profile und betétigen Sie die Eingabetaste.

4

. Wihlen Sie in der Zeile 0SD transparency durch Betdtigung der F8-Taste zwi-
schen folgenden Optionen:

high » hohes Durchscheinen des Bildschirminhalts

average » mittleres Durchscheinen des Bildschirminhalts (Standard)
low » leichtes Durchscheinen des Bildschirminhalts

off » Uberdeckende Darstellung des On-Screen-Displays

5. Betitigen Sie die F2-Taste zur Speicherung der durchgefiihrten
Anderungen.

1. Klicken Sie im Strukturbaum auf KVM-Extender > [Alle Extender].

2. Doppelklicken Sie das Rechnermodul des zu konfigurierenden KVM-
Extenders.

©
f=
©
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3. Klicken Sie auf die Reiter Remote > Extendersysteme > Personliches Profil.
4. Wiéhlen Sie im Feld 0SD-Transparenz zwischen folgenden Optionen:

Hoch » hohes Durchscheinen des Bildschirminhalts

Mittel » mittleres Durchscheinen des Bildschirminhalts (Standard)
Niedrig » leichtes Durchscheinen des Bildschirminhalts

Aus » Uberdeckende Darstellung des On-Screen-Displays

5. Klicken Sie auf 0K, um die erfassten Daten zu speichern.
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Position der Informationseinblendung dndern

In der Standardeinstellung erfolgen die Informationseinblendungen links oben auf
dem Bildschirm des Arbeitsplatzes. Die Position der Einblendung kénnen Sie nach
Thren Wiinschen anpassen.

So dndern Sie die Position der Informationseinblendung:
. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).

. Wéhlen Sie die Zeile Console setup und betétigen Sie die Eingabetaste.

. Wiébhlen Sie die Zeile Personal Pprofile und betétigen Sie die Eingabetaste.

B W N

. Wihlen Sie die Zeile Set display position und betitigen Sie die Eingabetaste.

An der aktuellen Position der Informationsein- +
blendung erscheint das rechts abgebildete Menti. [Display position
F2: Save

5. Verwenden Sie die Pfeiltasten oder die Maus, um
das Menii an die gewiinschte Position zu verschieben oder betétigen Sie die
Tastenkombination Strg+D zur Wiederherstellung der Standardposition.

6. Betitigen Sie die F2-Taste zur Speicherung der durchgefithrten Anderun-
gen oder die Esc-Taste zum Abbruch der Aktion.

Position des On-Screen-Displays andern

Das On-Screen-Display wird in der Standardeinstellung zentriert auf dem Bild-
schirm des Arbeitsplatzes dargestellt. Die OSD-Position kénnen Sie nach IThren
Wiinschen anpassen.

So dndern Sie die Position des On-Screen-Displays:
. Starten Sie das On-Screen-Display mit dem Hotkey Strg+Num (Standard).
. Wihlen Sie die Zeile Console setup und betitigen Sie die Eingabetaste.

. Wihlen Sie die Zeile Personal Pprofile und betétigen Sie die Eingabetaste.

. Wiébhlen Sie die Zeile Set menu position und betdtigen Sie die Eingabetaste.

g R W N =

. Verwenden Sie die Pfeiltasten oder die Maus, um das On-Screen-Display an
die gewlinschte Position zu verschieben oder betétigen Sie die Tastenkom-
bination Strg+D zur Wiederherstellung der Standardposition.

6. Betitigen Sie die F2-Taste zur Speicherung der durchgefithrten Anderun-
gen oder die Esc-Taste zum Abbruch der Aktion.
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Weiterfithrende Informationen

DDC-Weiterleitung mit Cache-Funktion

Der KVM-Extender unterstiitzt Enhanced-DDC (Enhanced Display Data Channel),
um die Eigenschaften des am Arbeitsplatzmoduls angeschlossenen Monitors auszu-
lesen und an den Rechner weiterzuleiten. Diese Eigenschaften umfassen beispiels-
weise Informationen tber die bevorzugte Auflosung und die unterstiitzten
Frequenzen des Monitors.

Damit der am Rechnermodul (DP-Vision-IP-CPU) angeschlossene Rechner schon
wéhrend des Bootvorgangs Zugriff auf die Eigenschaften des entfernten Monitors
hat, ist eine Cache-Funktion in den KVM-Extender integriert. Auch wenn das
Rechner- oder das Arbeitsplatzmodul ausgeschaltet oder nicht miteinander verbun-
den sind, stehen entweder die Eigenschaften des zuletzt angeschlossenen Monitors
oder die Werksvorgabe des KVM-Extenders zu Verfiigung.

Ublicherweise werden die DDC-Informationen des Monitors unverindert an den Rech-
ner weitergeleitet. Stellt der KVM-Extender aber fest, dass sich die Informationen des
Monitors nicht vollstindig auslesen lassen oder diese unzuldssige Eintrdge enthalten,
werden die Informationen (wenn moglich) vervollstandigt oder korrigiert.

Ermittlung der Netzwerkeinstellungen iiber den
Service-Port

Falls Thnen die IP-Adresse eines Arbeitsplatz- oder Rechnermoduls unbekannt ist,
konnen Sie diese tiber den Service-Port des Moduls anzeigen.

Verwenden Sie ein beliebiges Terminalemulationsprogramm (beispielsweise Tera Term
oder PuTTY) um die Log-Meldungen der Module anzuzeigen.

Installation des Geratetreibers

Installieren Sie vor der Einrichtung der Verbindung im Terminalemulationspro-
gramm den Geratetreiber CP210x USB to UART Bridge VCP.

HINWEIS: Der Treiber stellt die per Servicekabel verbundene Service-Buchse eines
Arbeitsplatz- oder Rechnermoduls als virtuelle serielle Schnittstelle (COM-Port)
zur Verfigung. Die virtuelle Schnittstelle kann anschliefend im Terminal-
emulationsprogramm zum Verbindungsaufbau ausgewéhlt werden.

So installieren Sie den Geritetreiber zur Adressierung der Service-Buchse:

1. Offnen Sie im Webbrowser des Computer die Website www.gdsys.de.

2. Navigieren Sie in den Bereich Downloads > Tools & Treiber der Website.

3. Downloaden Sie den Geratetreiber fiir das Betriebssystem des Computers.

4. Fihren Sie die Datei aus und folgen Sie den Hinweisen des Installationsassistenten.
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Einrichten einer Verbindung im Terminalemulationsprogramm

So richten Sie die Verbindung im Terminalemulationsprogramm ein:

1. Starten Sie ein beliebiges Terminalemulationsprogramm (beispielsweise Tera Term
oder PuTTY).

2. Erstellen Sie eine neue Verbindung im Terminalemulationsprogramm und erfas-
sen Sie folgende Verbindungseinstellungen:

= Bits pro Sekunde: 115.200

= Datenbits: 8
= Paritit: Keine
= Stoppbits: 1
= Flusssteuerung: Keine

3. Verwenden Sie das mitgelieferte USB-Servicekabel, um den Rechner mit der Ser-
vice-Buchse an der Frontseite des Arbeitsplatz- bzw. Rechnermodul zu verbinden.

Ermittlung der IP-Adresse

So ermitteln Sie die IP-Adresse des Arbeitsplatz- bzw. Rechnermoduls:
1. Starten Sie das Arbeitsplatz- bzw. Rechnermodul neu.

Wiéhrend des Bootvorgangs werden verschiedene Statusmeldungen im
Terminalemulationsprogramm angezeigt.

2. Nach Abschluss der Boot-Vorgangs wird die IP-Adresse gemeinsam mit anderen
Systeminformationen ausgegeben.
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Pin-Belegung der RS232-Buchse/Schnittstelle

Die Pin-Belegungen des RS232-Steckers sowie der -Buchse zeigen die folgenden
Abbildungen:

Arbeitsplatzmodul Rechnermodul
O (1]2]3]4]5] O O (5] [4][3][2] [1] O
(6 7]38]9] 9] 6]
RS232-Stecker RS232-Buchse

Die Tabelle zeigt die Zuordnung der verschiedenen Leitungen der Datenverbindung
zu den entsprechenden Pins auf:

Pin-Nr. Leitung Arbeitsplatz- Rechner-
modul modul

1 DCD (Data Carrier Detect) Eingang Ausgang
2 RxD (Receive Data) Eingang Ausgang
3 TxD (Transmit Data) Ausgang Eingang
4 DTR (Data Terminal Ready) Ausgang Eingang
5 GND (Ground) Ground Ground
6 DSR (Dataset Ready) Eingang Ausgang
7 RTS (Request to Send) Ausgang Eingang
8 CTS (Clear to Send) Eingang Ausgang
9 nicht belegt n/c n/c
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Statusanzeigen

Die LEDs an den Front- und Riickseiten des Rechner- und des Arbeitsplatzmoduls
geben Thnen die Moglichkeit, den Betriebsstatus des KVM-Extenders jederzeit zu

kontrollieren.

Bedeutung der LEDs

Bereich  LED Farbe Status  Bedeutung
Ident. Ident. blau an Leuchtet, sobald die LED {iber die Webapplikation
aktiviert wurde.
Power Red. griin an Das optionale Netzteil ist angeschlossen und
eine Spannung von 12 Volt verfiigbar.
aus Das optionale Netzteil ist nicht (korrekt) ange-
schlossen.
Main griin an Das Netzteil ist eingeschaltet und liefert die
erforderliche Spannung.
aus Das Netzteil ist ausgeschaltet oder die Verbin-
dung mit dem Stromnetz nicht hergestellt.
Status K/M griin an Die Tastatur wurde erkannt.
blinkt Keine Tastatur angeschlossen oder nicht erkannt.
System griin an Gerdt betriebsbereit.
blinkt Update wird ausgefiihrt.
blinkt Riicksetzung auf Werkseinstellungen nach
schnell  langem Druck auf den Reset-Taster.
rot an interner Fehler
Channel Video gelb an Am Videoeingang wurde ein stabiles Bildsignal
festgestellt.
aus Das eingehende Videosignal wurde nicht erkannt
oder es ist qualitativ nicht ausreichend, um ver-
arbeitet zu werden.
Pairing gelb an Es besteht eine aktive Verbindung zur
Gegenstelle.
aus Es besteht keine aktive Verbindung zur
Gegenstelle.
Network links gelb an Verbindung zur Gegenstelle hergestellt.
aus Verbindung zur Gegenstelle nicht hergestellt.
rechts griin an Verbindung zur Gegenstelle hergestellt.
aus Verbindung zur Gegenstelle nicht hergestellt.
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Technische Daten

Alilgemeine Eigenschaften der Serie

DP-VISION-IP-SERIE

Schnittstellen fiir Video: » siehe spezifische Eigenschaften
Rechner PS/2-Tastatur/Maus: 2 x PS/2-Buchse
USB-Tastatur/Maus: 1 x USB-B-Buchse
Audio: 3,5-mm-Klinkenbuchse (Line In)
3,5-mm-Klinkenbuchse (Line Out)
RS232: 1 x RS232-Buchse
Schnittstellen fiir Monitor: » siehe spezifische Eigenschaften
Ie\rrllt)];?::'s‘;f:tz PS/2-Tastatur/Maus: 2 x PS/2-Buchse
USB-Tastatur/Maus: 2 x USB-A-Buchse
Generic-HID: 1 x USB-A-Buchse
Audio: 3,5-mm-Klinkenbuchse (Speaker)
3,5-mm-Klinkenbuchse (Micro In)
RS232: 1 x RS232-Stecker
Schnittstellen fiir Monitor: » siehe spezifische Eigenschaften
lokalen Arbeitsplatz PS/2-Tastatur: 1 x PS/2-Buchse
USB-Tastatur/Maus: 2 x USB-A-Buchse
Sonstige Netzwerkanbindung: 1 x RJ45-Buchse (1000 MBit/s)
Schnittstellen Service: 1 x Mini-USB-Buchse (Typ B)
Grafik Format: DisplayPort (DP 1.1a)
Farbtiefe: 24 Bit
Pixelkodierung: RGB 4:4:4 mit 24bpp/8bpc
Videobandbreite: 25 bis 300 MP/s

max. Aufldsung:

= 2560 x 1600 (60 Hz

Auflosungsbeispiele:

= 3840 x 2160 (30 Hz
= 2048 x 2048 (60 Hz
= 1920 x 1200 (60 Hz)

» weitere standardisierte Auflosungen
méglich

= 4096 x 2160 (30 Hz§
)
)

Vertikalfrequenz:

24 Hz bis 120 Hz

Horizontalfrequenz:

25 kHz bis 185 kHz
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DP-VISION-IP-SERIE

Audio Ubertragungsart: transparent, bidirektional
Aufldsung: 24 bit digital, Stereo
Abtastrate 96 kHz
Bandbreite: 22 kHz
RS232 Ubertragungsart: transparent
Ubertragungsrate: max. 115.200 bit/s
Ubertragene Signale: RxD, TxD, RTS, CTS, DTR, DSR, DCD
Hauptstrom- Typ: internes Netzteil
versorgung Anschluss: Kaltgerdtestecker (IEC-320 C14)
Spannung: AC100-240V/60-50Hz
redundante Strom-  Typ: externes Netzteil
versorgung Anschluss: miniDIN-4 Power-Buchse
Spannung: +12VDC
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Spezifische Eigenschaften der Gerate

DP-VISION-CAT-AR-CPU

Schnittstellen fiir Monitor: 1 x DisplayPort-Buchse

lokalen Arbeitsplatz

Schnittstellen fiir Video: 1 = DisplayPort-Buchse

Rechner

Gehduse Material: Aluminium eloxiert
Dimensionen (BxHxT): 210 x 44 x 210 mm
Gewicht: ca. 1,3kg

Stromaufnahme Hauptstromversorgung: ~ 100-240 VAC/606-50 Hz/0.3-0.2 A
redundante 12VDC/0.9 A
Stromversorgung:

Einsatzumgebung Temperatur: +5 bis +45 °C
Luftfeuchte: < 80 %, nicht kondensierend

DP-VISION-CAT-AR-CON

Schnittstellen fiir Monitor: 1 x DisplayPort-Buchse
entfernten Arbeitsplatz
Gehduse Material: Aluminium eloxiert
Dimensionen (B x H x T): 210 x 44 x 210 mm
Gewicht: ca. 1,3 kg
Stromaufnahme Hauptstromversorgung: ~ 100-240 VAC/60-50 Hz/0.3-0.2 A
redundante 12VDC/1.2 A
Stromversorgung:
Einsatzumgebung Temperatur: +5 bis +45 °C
Luftfeuchte: < 80 %, nicht kondensierend
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About this manual
This manual has been carefully compiled and examined to the state-of-the-art.

G&D neither explicitly nor implicitly takes guarantee or responsibility for the qual-
ity, efficiency and marketability of the product when used for a certain purpose that
differs from the scope of service covered by this manual.

For damages which directly or indirectly result from the use of this manual as well
as for incidental damages or consequential damages, G&D is liable only in cases of
intent or gross negligence.

Caveat Emptor

G&D will not provide warranty for devices that:

= Are not used as intended.

= Are repaired or modified by unauthorized personnel.

= Show severe external damages that was not reported on the receipt of goods.
= Have been damaged by non G&D accessories.

G&D will not be liable for any consequential damages that could occur from using
the products.
Proof of trademark

All product and company names mentioned in this manual, and other documents
you have received alongside your G&D product, are trademarks or registered trade-
marks of the holder of rights.

© Guntermann & Drunck GmbH 2017. All rights reserved.

Version 1.00 - 12/05/2017
Firmware: 1.0.000

Guntermann & Drunck GmbH
Obere Leimbach 9
57074 Siegen

Germany

Phone +49 271 23872-0
Fax  +49 271 23872-120

http://www.gdsys.de
sales@gdsys.de

i - G&D DP-Vision-IP



FCC Statement

The devices named in this manual comply with Part 15 of the FCC Rules. Opera-
tion is subject to the following two conditions: (1) the devices may not cause harm-
ful interference, and (2) the devices must accept any interference received, including
interference that may cause undesired operation.

NOTE: This equipment has been found to comply with the limits for a Class A dig-
ital device, pursuant to Part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful inter-
ference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful inter-
ference in which case the user will be required to correct the interference at his
own expense.
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Safety instructions

Safety instructions

Please read the following safety instructions carefully before you start operating the
G&D product. The instructions well help in avoiding damages to the product and in
preventing possible injuries.

Keep this manual handy for all persons who will be using this product.

Follow all warnings or operating instructions which are on the device or stated in
this user manual.

A

Beware of electric shocks

To avoid the risk of electric shock, do not open the device or remove the covers.
If service is required, please contact our technicians.

Disconnect the main power plug or the power supply before installation
Before installation, ensure that the device has been disconnected from the power
source. Disconnect the main power plug or the power supply of the device.
Ensure constant access to the power plugs

During the installation of the devices, ensure that the power plugs remain accessible.

Do not cover the ventilation openings
Ventilation openings prevent the device from overheating. Do not cover them.

Ensure proper installation position
For reasons of electric safety, the device has to be installed upright and horizontally.

Avoid tripping hazards
Avoid tripping hazards while laying cables.

Only use a grounded voltage source
Operate this device by using a grounded voltage source.

Use only the provided G&D power pack

Operate this device with the provided G&D power pack or with the power pack
listed in the manual.

Operate the device only in designated areas.

The devices are designed for indoor use. Avoid exposure to extreme cold, heat
or humidity.as well as
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The DP-Vision-IP series

The DP-Vision-IP series

KVM extenders of the DP-Vision-IP series consist of a computer module and a user
modules.

Connect the computer to be operated as well as an optional console to the computer
module (DP-Vision-IP-CPU). The remote console is connected to the user module
(DP-Vision-IP-CON).

Both the computer and the user module are connected via category 5e (or better)
twisted pair cables over an IP-based Gigabit Ethernet.

When observing the max. length of sections between two active network components
(up to 100 meters each), the entire transmission length is unrestricted.

NOTE: You can also use category 5e (or better) twisted pair cables to establish a
direct connection between computer module and user module.

G&D’s KVM-over-IP™ technology makes it possible to transmit signals between the
computer and the user module compressed and encrypted (AES-128) using Gigabit
Ethernet (Layer 3).

If the bandwidth of the Gigabit Ethernet is sufficient, the video signal is reproduced
in a loss-free video quality and almost without any latency. By means of manual
bandwidth management you can adapt the transmission to different bandwidth
requirements (see Limiting the bandwidth on page 17).

The computer can either be operated at the remote console of the user module or at
the local console of the computer module.

IMPORTANT: Data transmission of devices of the DP-Vision-IP series is not compati-
ble to G&D devices of other series!
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Package contents

Package contents

The KVM extender system consist of a computer module (DP-Vision-IP-CPU) and a
user module (DP-Vision-IP-CON).

Additionally, the package contents include the following accessories:

= 2 X power cable (PowerCable-2 Standard)

= 1 x video cable (DP-Cable-M/M-2)

= 1 X USB device cable (USB-AM/BM-2)

= 2 X audio cable (Audio-M/M-2)

= 1 X serial connection cable (RS232-M/F-2)
= 1 x service cable (USB-Service-2)

= 1 X Installation and Operating Guide

= 1 X manual of web application Config Panel
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Installation

Installation

Preparation

IMPORTANT: When choosing a location for the devices, please ensure to comply
with the ambient temperature limit (see Technical data on page 58 ff.) close to the
device. The ambient temperature limit must not be influenced by other devices.

1. Ensure that the computer to be connected to the computer module is switched
off. If the computer is provided with keyboard and mouse, unplug the cables of
the input devices from the interfaces.

2. Place the computer module (DP-Vision-IP-CPU) close to the computer.

NOTE: Please mind the maximum cable length of five meters between the com-
puter module and the computer to be connected.

3. Place the user module (DP-Vision-IP-CON) close to the remote console.

NOTE: Please mind the maximum cable length of five meters between the user
module and the devices of the user console.

4. Take the supplied cables and have them ready for the installation of the devices.

G&D DP-Vision-IP - 4



Installation

Installing the computer module

The computer, whose signals are transmitted to the remote console, is connected to
the DP-Vision-IP-CPU computer module. If desired, connect a local console to the
computer module.

Establishing a connection to a local network

Dil:l

Network

Network: Insert a category 5 twisted pair cable (or better), which is available as acces-
sory. Connect the other end of the cable to the Gigabit Ethernet.

IMPORTANT: For the initial setup of the computer module use a category 5e (or
better) twisted pair cable to establish a direct connection to the user module.

Connecting keyboard and mouse to the local computer

@ @A

Keyb. CPU Mouse CPU USB CPU

NOTE: Mouse and keyboard signals of both consoles can either be transmitted to
the computer using the USB interface USB CPU or using the PS/2 interfaces Mouse
CPU and Keyb. CPUPS/2.

USB CPU: Use the USB-AM/BM:-2 cable to connect one of the computer’s USB inter-
faces to this interface.

Keyb. CPU: Use the green plug of an optionally available PS/2 cable (PS/2-M/M-2)
to connect the computer’s PS/2 keyboard interface to this interface.

Mouse CPU: Use the purple plug of an optionally available PS/2 cable (PS/2-M/M-2)
to connect the computer’s PS/2 mouse interface to this interface.
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Connecting the computer’s video output

DP CPU

DP CPU: Use the DP-Cable-M/M-2 cable to connect the computer’s video output to
this interface.

Connecting audio and RS232 interfaces

RS232

® ® OO

In Line Out

NOTE: By default, the KVM switch transfers audio data between switches.
In addition, you can enable the transmission of RS232 data and, alternatively,
disable the transmission of audio data (see (De)Activating signals on page 18).
Line In: Use an Audio-M/M-2 audio connection cable to connect the omputer’s Line-
Out interface to this interface

Line Out: Use an Audio-M/M-2 audio connection cable to connect the omputer’s Line-
Ininterface to this interface.

R8232: Use the RS232-M/F-2 cable to connect one of the computer’s 9-pin serial
interfaces to this interface.
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Optional: Connecting a local console

Keyb./Mouse

DP Out

NOTE: The keyboard of the local console can either be a PS/2 or a USB device. ‘

ADVICE: Use the adapter MD6M-2xMD6F (A6400043) to use a PS/2 keyboard and a
USB mouse at the same time.

Keyb./Mouse: Connect the mouse and/or the keyboard of the local console to this
interface.

DP Out: Connect the monitor of the local console to this interface.

Establishing the power supply

Red. Power

Red. Power: To provide a second, redundant power supply, connect a portable power
pack to this interface.

Main Power

Main Power: Insert one of the supplied IEC cables here.
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Installing user modules

The remote console is connected to the DP-Vision-IP-CON user module. The computer
connected to the computer module can be operated from this console.

Establishing a connection to a local network

DHD

Network

Network: Insert a category 5 twisted pair cable (or better), which is available as acces-
sory. Connect the other end of the cable to the Gigabit Ethernet.

IMPORTANT: For the initial setup of the user module use a category 5Se (or better)
twisted pair cable to establish a direct connection to the computer module.

Connecting keyboard and mouse of consoles

Mouse

Generic

Keyb./Mouse ~ Keyb.

NOTE: Both the keyboard and the mouse of the console can either be PS/2 or USB
devices.

Keyb./Mouse: Connect the mouse and/or the keyboard of the console to this interface.

Generic: In the default settings, you can use this interface to connect another USB
input device or a supported display or tablet.

Activate the generic HID mode (see Selecting the USB-HID mode on page 40) if you want
to connect another USB input device. In this mode, any data of the USB input device
is not altered when transmitted to the computer module.

IMPORTANT: If the generic HID mode is active, the OSD cannot be operated by a
keyboard connected to the Generic socket.

Keyb.: Connect the PS/2 keyboard of the console.

Mouse: Connect the PS/2 mouse of the console.
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Connecting the console monitor

DP Out

DP Out: Connect the console monitor.

Connecting audio and RS232 interfaces

RS232

oo

® @®

Micro In - Speaker

NOTE: By default, the KVM switch transfers audio data between switches.

In addition, you can enable the transmission of RS232 data and, alternatively,
disable the transmission of audio data (see (De)Activating signals on page 18).

Micro In: If required, connect a microphone to this interface.
Speaker: Connect the speakers or another audio output device.

RS232: Connect the serial end device to this interface.

Establishing the power supply

Red. Power

Main Power

Main Power: Insert one of the supplied IEC cables here.

Red. Power: To provide a second, redundant power supply, connect a portable power
pack to this interface.
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Start-up

After the proper installation of the KVM extenders they can be immediately put into
operation.

Mind the following activation sequence when starting the modules:
1. Turn on the user module DP-Vision-IP-CON.
2. Turn on the computer module DP-Vision-IP-CPU.

3. Turn on the computer that is connected to the computer module.

NOTE: The recommended activation sequence ensures that the KVM extenders
are able to read out the features of the connected monitor and to transmit them to
the computer (see DDC transmission with cache function on page 53).

Starting process

After the computer module and the user module are turned on, the LEDs on the
front panel show the module’s operating status.

For further information about this topic, also see the chapter Status LEDs on
page 56 ff.

On-screen display of the user module

When starting the user module, information about the starting process as well as the
firmware versions and IDs of the connected modules are displayed in the monitor of
the user module.

Additionally, the local hotkey (default: Alt+Num) to open the local OSD of the user
module and the remote OSD remote hotkey (default: Ctrl+Num) to open the remote
OSD of the computer module are shown.

ADVICE: Press Pause to stop the process. Pressing Space continues the process.
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Establishing a KVM-over-IP™
connection for the first time

IMPORTANT: Change the default IP addresses before integrating several computer
or user modules into the productive network.

G&D’s KVM-over-IP™ technology makes it possible to transmit signals between the
computer and the user module using a Gigabit Ethernet (layer 3).

The communication between two modules requires various settings. In the default
settings, the modules are configured in a way that a computer and a user module
can immediately establish a direct connection.

All computer modules are preconfigured with the IP address 172.17.0.10, all user
modules with the IP address 172.17.0.11.

ADVICE: If you do not know the IP address of an already configured user or com-
puter module, it can be determined via the log messages of the device. For more
information, see the section Determining network settings via service port on page 53.

Default setting of the modules

ADVICE: You can restore the default settings using the front panel of each module.
For this, follow the instructions given under Resetting the default settings on page 21.

The default setting of the modules allows users to quickly establish a direct connec-
tion between a computer and a user module. The OSD lets you adjust the configura-
tion of both modules after their initial operation.

Both the IP addresses and the KVM-over-IP settings are preconfigured as follows:

DEFAULT SETTING OF THE COMPUTER MODULE (CPU)

IP address: 172.17.0.10
Netmask 255.255.0.0
Control port: 18246
Communication port: 18245
Data port: 18244

11 - G&D DP-Vision-IP



Establishing a KVM-over-IP™ connection for the first time

DEFAULT SETTING OF THE USER MODULE (CON)

IP address: 172.17.0.11
Netmask 255.255.0.0
Local control port: 18246
Local communication port: 18245
Local data port: 18244
Remote host: 172.17.0.10
Remote control port: 18246

NOTE: The IP address of the computer module (host) as well as the control port of the
computer module must be specified to establish a KUM-over-IP connection through
the user module.

The configuration of both the communication ports and the data ports are automati-
cally exchanged between the two modules.

Preparations for the initial setup

= Install the computer and the user module (see page 4 ff.).

= Use a category 5e (or better) twisted pair cable to connect the Network interface of
the computer module to the Network interface of the user module.

= Turn on both the comuter and the user module (see page 10 ff.).

Configuring a KVM-over-IP connection of a computer
module

You can carry out the required configuration settings directly on the console.

NOTE: Use the local hotkey (default: Alt+Num) to open the local OSD to configure
the network interface of the user module, or use the remote hotkey (default:
Ctrl+Num) to open the remote OSD to configure the network interface of the com-
puter module.

The settings of both hotkeys are shown during the starting process of the user
module (see Starting process on page 10).

IMPORTANT: The OSD of the computer module can be opened only if a KVM-over-IP
connection to the computer module is established.

Therefore, you have to change the configuration of the computer module first.
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Configuring the network interface

How to configure the network interface:

1. Use the remote hotkey Ctrl+Num to open the OSD of computer module.
2. Select the entry Network setup and press Enter.

3. Select the entry Interfaces and press Enter.

4. Enter the following data under Interface A:

Operational Press F8 to select the operational mode of the interface:

LT = Static: A static IP address is assigned.

= DHCP: IP address is obtained from a DHCP server.
IP address: Enter the IP address of the interface.

The operational mode DHCP does not allow making entries.
Netmask: Enter the netmask of the network.

The operational mode DHCP does not allow making entries.

5. Press F2 to save your settings.

Configuring the global network settings

Even in complex networks global network settings ensure that the KVM extender is
available from all partial networks.

How to configure global network settings:

1. Use the remote hotkey Cirl+Num to open the OSD of computer module.
2. Select the entry Network setup and press Enter.

3. Select the entry Interfaces and press Enter.

4. Enter the following data under Main Network:

Global Press F8 to select the global preferences:

references: . . .
P = Static: uses static settings.

= DHCP: obtains settings from a DHCP server.

Hostname: Enter the device hostname.

Domain: Enter the domain the device is to belong to. ‘
Gateway: Enter the gateway IP address.

DNS 1: Enter the IP address of the DNS server. ‘
DNS 2: Optionally, enter the IP address of another DNS server.

5. Press F2 to save your settings.
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Configuring a KVM-over-IP connection

The IP address of the user module (host) as well as the control port of the computer
module must be specified to establish a KVUM-over-IP connection through the com-
puter module.

The configuration of both the communication poris and the data porits are automatically
exchanged between the two modules.

NOTE: The configuration of both the communication ports and the data ports are
automatically exchanged between the two modules.

How to configure a KVM-over-IP connection:

1. Use the remote hotkey Ctrl+Num to open the OSD of computer module.
2. Select the entry KVM connection and press Enter.

3. Enter the following data under Network setting :

Control port: Enter the number of the port you want to use.
Communication port:  Enter the number of the port you want to use.

Data port: Enter the number of the port you want to use.

4. Press F2 to save your settings.

Configuring a KVM-over-IP connection of a user
module

You can carry out the required configuration settings directly on the console.

NOTE: Use the local hotkey (default: Alt+Num) to open the local OSD to configure
the network interface of the user module, or use the remote hotkey (default:
Ctrl+Num) to open the remote OSD to configure the network interface of the com-
puter module.

The settings of both hotkeys are shown during the starting process of the user
module (see Starting process on page 10).

Configuring the network interface

How to configure the network interface:

1. Use the remote hotkey Alt+Num to open the OSD of user module.
2. Select the entry Network setup and press Enter.

3. Select the entry Interfaces and press Enter.
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4. Enter the following data under Interface A:

Operational Press F8 to select the operational mode of the interface:

LT = Static: A static IP address is assigned.
= DHCP: IP address is obtained from a DHCP server.

IP address: Enter the IP address of the interface.

The operational mode DHCP does not allow making entries.
Netmask: Enter the netmask of the network.

The operational mode DHCP does not allow making entries.

5. Press F2 to save your settings.

Configuring the global network settings

Even in complex networks global network settings ensure that the KVM extender is
available from all partial networks.

How to configure global network settings:

1. Use the remote hotkey Alt+Num to open the OSD of the user module.
2. Select the entry Network setup and press Enter.

3. Select the entry Interfaces and press Enter.

4. Enter the following data under Main Network:

Global Press F8 to select the global preferences:

references: . . .
p = Static: uses static settings.

= DHCP: obtains settings from a DHCP server.

Hostname: Enter the device hostname.
Domain: Enter the domain the device is to belong to. ‘
Gateway: Enter the gateway IP address.

DNS Server 1:  Enter the IP address of the DNS server. ‘
DNS Server 2:  Optionally, enter the IP address of another DNS server.

5. Press F2 to save your settings.
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Configuring a KVM-over-IP connection

The IP address of the user module (host) as well as the control port of the computer
module must be specified to establish a KVUM-over-IP connection through the com-
puter module.

The configuration of both the communication poris and the data porits are automatically
exchanged between the two modules.

NOTE: The configuration of both the communication ports and the data ports are
automatically exchanged between the two modules.

How to configure a KVM-over-IP connection:

1. Use the remote hotkey Alt+Num to open the OSD of the user module.

2. Select the entry KVM Connection and press Enter.

3. Enter the following data under Local:

Control Port: Enter the number of the port you want to use.
Communication Port:  Enter the number of the port you want to use.

Data Port: Enter the number of the port you want to use.

4. Enter the following data under Remote:

Host: Enter the IP address of the computer module.

Control Port: Enter the number of the Control Port configured in the
computer module.

5. Press F2 to save your settings.

Connecting modules to a productive network

= Disconnect the direct connection between the Network interface of the computer
module and the Network interface of the user module.

= Connect the Network interfaces of both modules to a Gigabit Ethernet.
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Extended settings of KVM-over-IP connection

Limiting the bandwidth

By default, the KVM extender uses the maximum available bandwidth of a Gigabit
Ethernet. By means of manual bandwidth management you can adapt the transmis-
sion to different bandwidth requirements.

How to set a limit for the bandwidth of a KVM-over-IP connection:
1. Use the remote hotkey Ctrl+Num to open the OSD of the computer module.
2. Select the row KVM connection and press Enter.

3. Under Bandwidth limit (Mb/s) you can set the bandwidth limit of a KVM-over-IP
connection in Mb/s.

NOTE: Entering the value 0 deactivates the limit.

4. Press F2 to save your settings.

Classifying IP packets (DiffServ)

For QoS purposes (Quality of Service) you have the possibility to use Differentiated
Services Codepoints (DSCP) to classify the IP packets.

Through this classification, you can prioritize the data packets, for example,
through a switch.

You can define a DSCP for the IP packets of the keyboard, mouse and control data
(Communication data packets), as well as the IP packets of the video, audio and RS232
data (Data data packets).

How to configure the DSCPs of the IP data packets:
1. Use the remote hotkey Ctrl+Num to open the OSD of the computer module.
2. Select the row KVM connection and press Enter.

3. Enter the following data under Network control:

DiffServ Communication: Define the Differentiated Services Codepoint (DSCP) to be
used for the classification of the IP packets of the Com-
munication data packets.

DiffServ Data: Define the Differentiated Services Codepoint (DSCP) to be
used for the classification of the IP packets of the Data
data packets.

4. Press F2 to save your settings.
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(De)Activating signals

By default, the KVM switch transfers not only keyboard, video and mouse data but
also audio data between switches.

In addition, you can enable the transmission of RS232 data and, alternatively,
disable the transmission of audio data.

How to (de)activate the transmission of audio or RS232 signals:
1. Use the remote hotkey Ctrl+Num to open the OSD of the computer module.

2. Select the row KVM connection and press Enter.

3. Under Activated signals use the arrow keys to check the box of the signal you want
to (de)activate and press F8.

4. Press F2 to save your settings.
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Operation

The computer connected to the computer module (DP-Vision-IP-CPU) can be operated
at the remote console of the user module as well as at the local console of the com-
puter module.

After their initiation, both consoles are enabled to operate the computer.

NOTE: The monitors of the remote and the local console of the KVM extender
always display the same image at the same time.

The paragraph Changing the video mode of consoles on page 34 explains how this set-
ting can be changed.

Concurrent operation of the KVM extender

If a user carries out a keyboard or a mouse input, the KVM extender automatically
locks the input devices of the concurrent console. The lock is lifted if no inputs are
made at the active console during the adjusted timing of the automatic input lock
(default: 1 second).

After the automatic input lock has been lifted, both consoles are again able to oper-
ate the computer.

As an alternative to operate the computer concurrently via consoles, the exclusive
operation (see page 19) can be activated.

Related topics:

= Changing the time span of the input lock on page 32
= Changing the video mode of consoles on page 34

Operating the KVM extender exclusively

Activate the right for permanent access to operate the KVM extender exclusively
with one console.

If this function is activated, the extender’s exclusive operation can be activated by
pressing the hotkey Hotkey+Print (default: Ctrl+Print).
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Immediately after pressing this hotkey, the input devices of the concurrent console
are deactivated. By pressing the hotkey again at the active console, users at both
consoles are again able to operate the KVM extender.

NOTE: After the exclusive operation of the KVM extender has been activated at
one console, the Caps Lock, Num as well as the Scroll Lock LEDs are blinking alter-
nately at the keyboard of the locked console.

The blinking Scroll Lock LED at the active console indicates the exclusive opera-
tion of the KVM extender.

ADVICE: In the standard configuration of the KVM extender, the computer’s
video signal is output at the active as well as the concurrent console monitor.

If necessary, change the video modes of the user modules (see page 34) to switch
off the image of the concurrent console while you operate the extender at the
other console.

= Right for exclusive access to the console on page 33
= Changing the video mode of consoles on page 34
= Changing the exclusive key on page 31

Switching power outlets

A compatible power switch (ePowerSwitch 1G R2, 4M+ R2 and 8M+ R2) lets you switch
the power supply of devices by using the KVM extender.

IMPORTANT: The configuration of power switches and the assignment of power
outlets is carried out in the web application Config Panel.

How to switch the power outlets assigned to the KVM extender:
1. Use the hotkey Ctrl+Num (default) to open the on-screen display.

2. Use the arrow keys to select the row Target Power.

NOTE: If the computer module is not assigned with at least one power outlet,
this entry cannot be selected and the text n.c. (not connected) is shown instead.

3. Press Enter to carry out one of the following options:

turn off» turn power outlet(s) off
turnon» turn power outlet(s) on
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Using the Reset button

The Reset button is located between the Identification LED and the Power LEDs on
the front panel of the computer module and the user module.

This button enables you to reset the default settings as well as to temporarily deacti-
vate the netfilter rules.

NOTE: As protection against pressing the button accidentally, it is located behind a
drilling in the front panel.

Use a thin, pointed item to press the button.

Resetting the default settings

Pressing and holding the button during booting resets the default setting of the module.

NOTE: When carrying out this function at the user module, the data is reset on the
local OSD. After this function has been carried out at the computer module, the
default settings of the KVM extender listed on page 23 are reactivated.

1. Switch off the device if in operation.
2. Press and hold the Reset button on the front panel of the device.
3. Keep the button pressed and switch on the device.

4. Release the button as soon as the green Switch LED is fast blinking.

NOTE: You can also reset the default settings using the OSD or the Config Panel
web application (see page 48).

‘When using the web application to reset the default settings, it is possible to keep the
configuration of the network interfaces.
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Temporarily deactivating the netfilter rules

In the default status of the KVM extender, all network computers have access to the
extender’s IP address (open system access).

The web application enables you to create netfilter rules to control access to the
extender. As soon as a netfilter rule has been created, the open access to the system
is deactivated and all incoming data packets are compared to the netfilter rules.

If the currently adjusted netfilter rules prevent the access to the web application,
they can be can temporarily deactivated in order to be edited.

How to temporarily deactivate the netfilter rules:

1. Switch on the device if it has been switched off and wait until it is ready for oper-
ation.

2. Press and hold the Reset button on the front panel of the device for five seconds.

‘ IMPORTANT: Now, the open system access is activated.

3. Use the Config Panel web application to edit the netfilter rules stored in the device
and, afterwards, save these rules.

IMPORTANT: The former settings are reactivated if no new netfilter rules are
created within 15 minutes.
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Configuration

The configuration of the KVM extender can be changed either using the on-screen
display (OSD) or the web application Config Panel:

= The on-screen display is shown on the console monitor. Most configuration settings
can be changed directly on the OSD of the console.

= The web application Config Panel provides a graphical user interface to configure
and monitor the KVM extender via web browser.

Overview of functions and default settings

The following table provides an overview of the configurable functions of the KVM
extender. It additionally lists the default settings and references to detailed descrip-
tions of the functions.

Function Default setting Page
Changing hotkeys Ctrl 28
Changing the 0SD key Num 29
Opening the on-screen display via double keypress turned off 30
Changing the exclusive key Print 31
Changing the time span of the input lock 1second 32
Right for exclusive access to the console given 33
Changing the video mode of consoles always on 34
Selecting the EDID mode of the KVM extender auto 36
Reducing the colour depth of the image data to be transmitted 24 bit 34
Freeze mode disabled 38
Selecting the USB-HID mode PC default 40
Support of special keyboards default 42
Changing the scancode set of PS/2 keyboards scancode set 2 43
Keyboard required to start the user module no 45
Adjusting the waiting period of the screensaver disabled 46
Selecting a keyboard layout for inputs via 0SD German 47
Resetting the default settings 48
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Function Default setting Page
Changing the colour of the information display light green 49
Information display temporary 50
Adjusting the transparency of the on-screen display average transparency 51
Changing the position of the information dispaly left upper corner 52
Changing the position of the on-screen display centred 52

The basic operation of the on-screen display (see page 24) and the web application

Config Panel (see page 26) is described on the following pages.

Operating the on-screen display at the console

The on-screen display (OSD) — just like the web application Config Panel, which is
described on the following — can be used to change the configuration of the KVM

extender.

The on-screen display can be opened by pressing a configured hotkey at the user
module. You can view and edit the settings of the KVM extender only in the remote

OSD of the computer module.

NOTE: Use the remote hotkey (default: Ctrl+Num) at the console to open and config-
ure the remote OSD of the computer module and the local hotkey (default: Alt+Num)
to open and configure the local OSD of the user module.

During the starting process of the user module, the settings of both hotkeys are

shown (see Starting process on page 10).

Showing the on-screen display at the console

How to open the on-screen display:

1. Press Ctrl+Num (standard) to open the on-screen display.

Layout of the on-screen display

After pressing the hotkeys, the OSD is displayed on the console monitor:

Configuration

@

Console setup

Target setup
System setup
Network setup
Information

Target power

Local console setup

@

ESC

turn off 3

The on-screen display consists of three parts:
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Header ®
List field @

Footer ®

The header shows the title of the current menu.

The list field shows the menu items of the selected menu.

there are two types of menu items:

Menu items with submenus:

These items are displayed with three dots (...) in the right col-
umn. Select these items with the arrow keys and press Enter to
open the submenu.

Menu items without submenus:

The current setting is shown behind the menti item and can be
changed directly.

The footer shows the most important keys to operate the cur-
rently displayed menu and further information if available.

Operating the on-screen display

The on-screen display is operated with the console keyboard. The following table
shows you a list of frequently used keys:

Arrow keys:

Enter:
Esc:

Tab key:

F2:

F8:

Ctrl+F8:

Press the arrow keys Up and Down (in some menus also Left and
Right) to move the cursor between the different menu items.

Use this key to confirm inputs of open a submenu.

This key closes the displayed menu and shows the superior
menu.

A message is shown if entries are changed but not saved.

Use this key to move the cursor within the list field from one
menu item to the next (or vice versa).

Press this key to save your settings.

The displayed menu closes after the settings are saved and the
superior menu is displayed again.

Press this key to switch between the different options of a menu
item.

Configuration settings with many options support this hotkey
to open a clearly-arranged list containing all options.
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Basic operation of the web application

The Config Panel web application provides a graphical user interface to configure and
monitor the KVM extender.

The web application uses the Java Web Start technology. This technology allows the
execution of the Java application, regardless of the settings and the Java compatibil-
ity of the web browser.

NOTE: The separate manual provides information about system requirements, the
required configuration of the network interfaces at the DP-Vision-IP devices and the
operation of the web application.

Starting the web application

How to start the Config Panel web application:

1. Enter the following URL in the address bar:
https://[IP address of the user or computer module]

2. Click on Download Config Panel.
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User authentication against the web application

After the certificates are authenticated, the login box opens.

How to log on to the Config Panel web application:

1. Enter the following data in the login box:

Username: Enter your username.
Password: Enter your user account password.
Select language: Select the language for the user interface:

= (Default): apply default setting
= English
= German

2. Click the Login button.

IMPORTANT: Change the default password of the admin account.

Use the access data listed below to log in to the web application. Now, change
the password as described in the separate manual of the web application.

Enter the default access data to log on to the administrator account:

= Username: Admin
= Password: 4658
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Configuration settings
Changing hotkeys

If many applications that use hotkeys are operated on one computer or if different
KVM devices are used in one cascade, the number of available hotkeys might be
restricted.

In case an application or another device used within the cascade use the same hot-
key, the hotkey can be changed.

NOTE: Select your desired key or key combination from the keys Ctrl, Alt, Alt Gr,
Win or Shift.

How to change the current hotkey:

. Press Ctrl+Num (default) to open the on-screen display.
. Select the row System setup and press Enter.

. Select the row Hotkey and press Enter.

B W N

. Under Modifier, select at least one of the listed hotkey modifiers by selecting
the box with the arrow keys. Press F8 to confirm your selection:

Ctrl  » Crrlkey (default)
At » Altkey

At Gr » Alr Grkey

Win » Windows key
Shift » Shiftkey

5. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.
. Double-click the computer module of the KVM extender to be configured.
. Click the General tab.
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. In the row Hotkey modifier of the Configuration paragraph select at least one of
the mentioned modifiers (Ctri, Alt, Alt Gr, Win or Shiff) by clicking the par-
ticular box(es).

. Click OK to save your changes.
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Changing the OSD key

The hotkey to open the OSD consists of at least one hotkey modifier (see Changing
hotkeys on page 28) and an additional OSD key. You can freely select these keys
from a number of selectable keys.

You can change both the hotkey modifier Cirl and the OSD key Num.

How to change the current OSD key:
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1. Press Ctrl+Num (default) to open the on-screen display.
2. Select the row System setup and press Enter.

3.
4

Select the row Hotkey and press Enter.

. Under Key, press F8 to select an OSD key. Now you can open the OSD

when pressing the OSD key together with the hotkey modifier(s):

Num » Num key (defaulr)
Pause » Pause key
Insert » Insert key
Delete » Delete key
Home » Homekey

End » Endkey

PgUp » Page Upkey
PgDn » Pace Down key
Space » Space key

. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.

. Double-click the computer module of the KVM extender to be configured.
. Click the General tab.

. Under Hotkey, you can select an OSD key. The OSD key can be pressed

together with the hotkey modifier(s) to open the on-screen display.

Select the OSD key from the keys Pause, Insert, Delete, Home, Page Up,
Page Down, Num, End or Space.

. Click OK to save your changes.
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Opening the on-screen display via double keypress

As an alternative to opening the on-screen display (OSD) with the hotkey Hot-
key+Num or Double hotkey+Num you can also open the OSD by pressing a configured
key twice.

How to enable/disable the activation of the on-screen display via double key-
press:
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. Press Cirl+Num (default) to open the on-screen display.

. Select the row System setup and press Enter.

. Select the row Hotkey and press Enter.

. Under 08D via 2x keypress select one of the following options:
0ff » OSD cannot be opened via double keypress (defaulf)
Cirl  » OSD is opened by pressing the Ctrl key twice
Alt  » OSD is opened by pressing the Alt key twice
Alt Gr » OSD is opened by pressing the Alt Grkey twice
Win » OSD is opened by pressing the Windows key twice
Shift » OSD is opened by pressing the Skiff key twice
Print » OSD is opened by pressing the Print key twice

. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.

. Double-click the computer module of the KVM extender to be configured.
. Click the General tab.

. Under 08D via double keypress select one of the following keys.

0ff » OSD cannot be opened via double keypress (defaul)
Cirl  » OSD is opened by pressing the Ctrl key twice

Alt » OSD is opened by pressing the Alt key twice

Alt Gr » OSD is opened by pressing the Alt Grkey twice

Win » OSD is opened by pressing the Windows key twice
Shift » OSD is opened by pressing the Shiff key twice

PriSc » OSD is opened by pressing the Print key twice

. Click OK to save your changes.
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Changing the exclusive key

After pressing the hotkey for the exclusive operation of the extender the input
devices of the concurrent console are disabled. Only after pressing the hotkey again

at the active console the KVM extender can again be operated by both consoles.

The hotkey for the exclusive operation consists of at least one hotkey modifier (see

Changing hotkeys on page 28) and an exclusive key. Both keys can be selected from a

number of available keys. You can change both the hotkey modifier Cirl and the
exclusive key Print.

How to change the exclusive key:

Config Panel

BN~

1. Press Ctrl+Num (default) to open the on-screen display.
2. Select the row System setup and press Enter.

3.
4

Select the row Hotkey and press Enter.

. Under Exclusive key press F8 to select on of the following options:

Backspace » Backspace key

PriSc v Print key (default)
Scroll v Scroll key
Num » Num key
Pause » Pause key
Insert v Insert key

Delete v Delete key
Home » Home key

End » Endkey

PgUp » Page Up key
PgDn » Page Down key
Space » Space key

. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.
. Double-click the computer module of the KVM extender to be configured.
. Click the General tab.

. Under Exclusive mode actionkey select one of the following keys:

Backspace, PrtSc, Scroll, Num, Pause, Insert, Delete, Home, End, Page Up, Page
Down and Space.

. Click OK to save your changes.
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Changing the time span of the input lock

When carrying out keyboard or mouse inputs at a console, the KVM extender auto-
matically locks the input devices of the concurrent console. The lock is lifted if no
input is made at the active console within the adjusted timing of the input lock
(default: 1 second).

After the lock has been lifted, both users can operate the computer again.

The time span of the input lock can be adjusted between 1 and 90 seconds.
How to change the timespan of the input lock:

. Press Cirl+Num (default) to open the on-screen display.
. Select the row System setup and press Enter.

. Select the row Hotkey and press Enter.

[ O S

. Under Multiuser input lock enter the desired timespan of the input lock (1 to 90
seconds).

5. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.
. Double-click the computer module of the KVM extender to be configured.
. Click the General tab.
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. Under Multiuser input lock enter the desired timespan of the input lock (1 to 90
seconds).

. Click OK to save your changes.

Related topic:
= Qperating the KVM extender exclusively on page 19
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Right for exclusive access to the console

If no inputs are made at the active console during the adjusted time span of the auto-
matic input lock (default: 1 second), the default settings of the KVM extender permit
the other console to operate the extender.

If the function right for exclusive console access is activated in the web application,
you are able to operate the KVM extender exclusively by pressing the hotkey Hot-
key+Print (default: Ctrl+Print).

Pressing this key combination deactivates the input devices of the concurrent con-
sole. By pressing the key combination again at the active console, both consoles can
operate the KVM extender again.

NOTE: After the exclusive operation of the KVM extender has been activated at a
console, the Caps Lock, Num and Scroll Lock LEDs are blinking alternately at the
keyboard of the locked console.

The blinking Scroll Lock LED at the active console indicates that the exclusive
operation of the KVM extender is activated.

How to select the right to exclusively operate a console:

1. Press Ctrl+Num (default) to open the on-screen display.

2. Select the row Console setup and press Enter if you want to adjust the right for
the remote console (at the CON module).

Select the row Local console setup and press Enter if you want to adjust the
right for the local console (at the CPU module).

3. Under Enable exclusive press F8 to select on of the following options:

yes» right for exclusive access is granted (default)
no » right for exclusive access is denied

4. Press F2 to save your settings.
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1. Click on KVM Extenders > [All Extenders] on the directory tree.
2. Double-click the computer module of the KVM extender to be configured.

3. Click on the tab Local if you want to adjust the right for the local console (at
the CPU module).
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Click on the tab Remote > General, if you want to adjust the right for the
remote console (at the CON module).

4. Under Permanent Access mode select one of the following options:

Enabled » right for exclusive access is granted (default)
Disabled » right for exclusive access is denied

5. Click OK to save your changes.

Related topics:

= QOperating the KVM extender exclusively on page 19
= Changing the video mode of consoles on page 34

Changing the video mode of consoles

In the standard configuration of the KVM extender, the computer’s image is output at
the monitor of the active console as well as at the monitor of the concurrent console.

You can also define that the image of the other console is deactivated during con-
sole inputs.

The image of the other monitor is shown again as soon as the user has finished their
inputs at the console.
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How to select the video mode of a console:

1.
2.
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Press Ctrl+Num (default) to open the on-screen display.

Select the row Console setup and press Enter if you want to adjust the video
mode for the remote console (at the GON module).

Select the row Local console setup and press Enter if you want to adjust the
video mode for the local console (at the CPU module).

. Under Video mode press F8 to select one of the following options:

always on » image is always on (default)
switch off » switch off image for actions at the other console

. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.
. Double-click the computer module of the KVM extender to be configured.

. Click on the tab Local if you want to adjust the video mode for the local

console (at the CPU module).

Click on the tab Remote > General if you want to adjust the video mode for
the remote console (at the CON module).

. Under Image display select one of the following options:

» always on(defaulr)
» off for actions at remote/local console

. Click OK to save your changes.

Related topics:

= Changing the time span of the input lock on page 32
= Right for exclusive access to the console on page 33
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Selecting the EDID mode of the KVM extender

EDID information (Extended Display Identification Data) of a monitor informs the gra-
phics card of a connected computer about different technical device features. The
information is usually transmitted via Enhanced-DDC (Enhanced Display Data Chan-
nel) and without any alteration between KVM extender and computer.

NOTE: For initial operation and when connecting another monitor, please follow
the activation sequence recommended on page 10.

Special GUD profiles are provided for some resolutions. The names of these profiles
contain information about the preferred resolution that is transmitted to the graphics
card of the computer when using this profile.

As an alternative, you can use the web application Config Panel to read out the EDID
profile of a monitor. The KVM extender then transmits it to the connected com-
puter. Detailed information about this topic is given in the separate manual of the
web application Config Panel.

How to select the EDID mode of KVM extenders:

1.
2.
3.

Press Ctrl+Num (default) to open the on-screen display.
Select the row Target setup and press Enter.
Under EDID mode press F8 to select on of the following options:

auto » automatic treatment of EDID data (defaulf)
user » use of a G&D profile or a profile that has been read out via
web application

. Ifthe option user has been selected, select the row Assign EDID and press Enter.

Use the arrow keys to select the profile you want the activate and press F8.
Save your selection by pressing F2.

. Press F2 to save your settings.
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1. Click on KVM Extenders > [All Extenders] on the directory tree.

2. Double-click the computer module of the KVM extender to be configured.
3. Click the General tab.
4.

Config Panel

Under Edid profile select one of the following options:

[Auto] » automatic treatment of EDID data defaulf)
GUD DVI ... » sue of a G&D profile for a particular resolution
Name » EDID profile that has been read out by the user

5. Click OK to save your changes.

Reducing the colour depth of the image data to be transmitted

In the default settings, the KVM extender transmits the image information with a
maximum colour depth of 24 bit to the user module.

Using a high resolution and displaying moving images can result in the user module
“skipping” several images.

In such cases, reduce the colour depth of the image data to 18 bits. This way the
data volume to be transmitted can be reduced.

NOTE: Depending on the image contents, reducing the colour depth may result in
slight colour grades.
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How to change the colour depth of the image data to be transmitted:

—_

. Press Ctrl+Num (default) to open the on-screen display.

N

. Select the row Target setup and press Enter.

w

. Under Color depth press F8 to select on of the following options:

24 Bit: » transmits the image data with a maximum colour depth
of 24 bits (defaulr)
18 Bit: » reduces the colour depth of image data to 18 bits

4. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.

. Double-click the computer module of the KVM extender you want to con-
figure.
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. Click on the tabs General.
. Under Color depth select one of the following options:

24 Bit: » transmits the image data with a maximum colour depth
of 24 bits (default)
18 Bit: » reduces the colour depth of image data to 18 bits

. Click OK to save your changes.

Freeze mode

If the cable connection between the computer module and the user module is inter-
rupted during operation, the KVM extender no longer displays an image at the remote
console.

Enable the Freeze mode if you want the last image that has been displayed at the user
module to be available until the connection is re-established.

To highlight an interrupted connection, the last available image can be displayed
with either a coloured frame and/or a Frozen popup and the time passed since the
connection has been interrupted.
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How to configure the Freeze mode:

1.
2.
3.
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Press Ctrl+Num (default) to open the on-screen display.
Select the row Console setup and press Enter.
Under Freeze mode press F8 to select on of the following options:

off » Freeze mode is disabled (defauir)
on » Freeze mode is enabled

. If the Freeze mode is active, press F8 to select one of the options available

under Freeze visualization:

frame » shows a coloured frame when disconnected
0SD » shows Frozen and the time passed since disconnection
frame+08D » shows a coloured frame (frame) and Frozen (0SD)

. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.

. Double-click the computer module of the KVM extender you want to con-

figure.

3. Click on the tabs Remote > General.

. Under Freeze mode select one of the following options (see above):

Disabled (defauir)
Enabled

. If the Freeze mode is active, additionally select one or both options available

under Freeze visualization:

Frame » shows a coloured frame when disconnected
0SD » shows Frozen and the time passed since disconnection

. Click OK to save your changes.
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Selecting the USB-HID mode

The KVM extender supports various USB input devices. You can use the special fea-
tures of a particular USB input device after selecting the specific USB keyboard
mode.

As an alternative to the specific USB keyboard modes, you can also use the generic
HID mode. In this mode, data of the USB device connected to the top Keyh./Mouse
socket of the user module is transmitted to the computer module without being
altered.

IMPORTANT: The generic HID mode supports many available HID device. How-
ever, being able to operate particular HID device in generic HID mode can not be
guaranteed.

IMPORTANT: When connecting a USB hub or a USB composite device, which
contains multiple USB devices, only the first of the connected HID devices can be
used in generic HID mode.

= USB keyboards: The default USB keyboard mode PC default supports the keys of the
default keyboard layout.

When using an Apple keyboard or a Sun keyboard special keyboard modes allow you to
use the special keys of these keyboards.

The following table lists the supported USB keyboards:

INPUT DEVICE SETTING

PC keyboard with default keyboard layout » PC default
PC keyboard with additional multimedia keys » Multimedia
Apple keyboard with numeric keypad (A1243) » Apple A1243
Sun keyboard (German keyboard layout) » SUN DE

Sun keyboard (US keyboard layout) » SUN US

= Displays and Tablets: You can operated the computer connected to the KVM

extender via a supported display or tablet:

INPUT DEVICE SETTING

HP 2310tk » HP 2310t

ilyama 71931 » iiyama 71931
NOTTROT N170 KGE » NOTTROT N170 KGE
Pixelpower » Pixelpower

Wacom Cintiq 21UX » Wacom Cint.21
Wacom Intuos3 » Wacom Int.3
Wacom Intuos4 S » Wacom Int.4S
Wacom Intuos4 M » Wacom Int.4M
Wacom Intuos4 L » Wacom Int.4L
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INPUT DEVICE SETTING
Wacom Intuos4 XL » Wacom Int.4XL
Wacom Intuos5 S » Wacom Int.5S
Wacom Intuos5 M » Wacom Int.5M
Wacom Intuos5 L » Wacom Int.5L

= Generic-HID mode: In this mode, data of the USB device connected to the top Keyb./
Mouse socket of the user module is transmitted to the computer module without
being altered.

INPUT DEVICE SETTING

any USB device » Generic HID

IMPORTANT: The generic HID mode supports many available HID device. How-
ever, being able to operate particular HID device in generic HID mode can not be
guaranteed.

= Controller: The multimedia controller ShuttlePRO v2 is used to operate various audio
and video programs. A special USB keyboard mode lets you use the controller to
operate the computer connected to the target module:

INPUT DEVICE SETTING
Contour ShuttlePRO v2 » Contour SP2

= LK463 compatible keyboard: You can connect an LK463 compatible keyboard to the
suer modules of the KVM matrix switch. The order of the 108 keys of these keyboards
corresponds to the OpenVMS keyboard layout.

A special USB keyboard mode guarantees that whenever a special key of this key-
board pressed, this action is transmitted to the target computer:

INPUT DEVICE SETTING
LK463 compatible keyboard » LK463
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How to select a USB-HID mode:

. Press Cirl+Num (default) to open the on-screen display.
. Select the row Target setup and press Enter.

. Select the row USB HID mode and press F8 key to select an option (see above).

Bwo N

. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.
. Double-click the computer module of the KVM extender to be configured.
. Click the General tab.
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. Under USB HID mode, select the desired option (see above).

(S O

. Click OK to save your changes.

Support of special keyboards
The KVM extender supports special functions of some special keyboards.

Enable the support of such keys if you want to use them at the console.
How to enable or disable the support for special keyboards:

1. Press Cirl+Num (default) to open the on-screen display.

2. Select the row Console setup and press Enter if you want to adjust the support
of a special keyboard for the remote console (at the CON module).

Select the row Local console setup and press Enter if you want to adjust the
support of a special keyboard for the local console (at the CPU module).

3. Under Enh. keyboard press F8 to select one of the following options:

no » disables support of special keyboards
PixelPower C » enables support of keyboard PixelPower Blue
SKIDATA1 » enables support of keyboard SKIDATAI

4. Press F2 to save your settings.
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1. Click on KVM Extenders > [All Extenders] on the directory tree.

2. Double-click the computer module of the KVM extender you want to con-
figure.

Config Panel

3. Click on the tab Local if you want to adjust the support of a special key-
board for the local console (at the GPU module).

Click on the tab Remote > General if you want to adjust the support of a spe-
cial keyboard for the remote console (at the CON module).

4. Under PS/2 keyboard type select one of the following options:

default » disables support of special keyboards
PixelPower Blue » enables support of keyboard PixelPower Blue
SKIDATA1 » enables support of keyboard SKIDATAI

5. Click OK to save your changes.

Changing the scancode set of PS/2 keyboards

If you press a key at the PS/2 keyboard, the keyboard processor sends a data packet
that is called scan code. The two common scancode sets (sets 2 and 3) contain differ-
ent scancodes.

In the default configuration, the KVM extender interprets any entry made at the
PS/2 keyboard with the scancode set 2.

«In

Use the scancode set 3 if you cannot enter the pipe
work as expected.

or the arrow keys do not
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How to change the setting of the scancode set:
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. Press Cirl+Num (default) to open the on-screen display.

. Select the row Console setup and press Enter if you want to adjust the scan-

code set of the remote console (at the GON module).

Select the row Local console setup and press Enter if you want to adjust the
scancode set of the local console (at the CPU module).

. Under Scancode set press F8 to select one of the following options:

2 » activates scancode set 2 for PS/2 keyboard inputs
3 » activates scancode set 3 for PS/2 keyboard inputs

. Press F2 to save your settings.

After you turn the KVM extender on again, the keyboard is initialised and the
selected scancode set is applied.

. Click on KVM Extenders > [All Extenders] on the directory tree.

. Double-click the computer module of the KVM extender you want to con-

figure.

. Click on the tab Local if you want to adjust the screensaver of the local con-

sole (at the CPU module).

Click on the tab Remote > General if you want to adjust the scancode set of
the remote console (at the CON module).

. Under Scancode set select one of the following options:

Set 2 activates scancode set 2 for PS/2 keyboard inputs
Set dactivates scancode set 3 for PS/2 keyboard inputs

. Click OK to save your changes.

. Turn the KVM extender off and on again.

After you turn the KVM extender on again, the keyboard is initialised and the
selected scancode set is applied.
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Keyboard required to start the user module

In the default settings, the user module starts even without a keyboard. As an alter-
native, the user module can interrupt the starting process when no keyboard is con-
nected. After you connect a keyboard to the user module, the starting process is
continued.

How to configure the starting behaviour without a keyboard connected to the
user module:

1.
2.
3.

N =

Config Panel

Press Ctrl+Num (default) to open the on-screen display.
Select the row Console setup and press Enter.
Under Keyboard required press F8 to select one of the following options:

no » continue starting process without a keyboard (default).
yes » interrupt starting process without a keyboard..

. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.

. Double-click the computer module of the KVM extender you want to con-

figure.

Click on the tab Remote > General.

. Under Keyboard required select one of the following options:

No » continue starting process without a keyboard (default).
Yes » interrupt starting process without a keyboard.

. Click OK to save your changes.
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Adjusting the waiting period of the screensaver

The screensaver turns off the display of the console after the user has been inactive
for a defined period of time.

NOTE: This setting does not affect the screensaver settings of the computer con-
nected to the computer module.

How to adjust the waiting period of the screensaver:

1.
2.
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Press Ctrl+Num (default) to open the on-screen display.

Select the row Console setup and press Enter if you want to adjust the screen-
saver of the remote console (at the CON module).

Select the row Local console setup and press Enter if you want to adjust the
screensaver of the local console (at the GPU module).

. Under Screensaver (min) enter a waiting period (1 to 999 minutes) for the

screensaver.

Entering the value 0 disables the screensaver.

. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.

. Double-click the computer module of the KVM extender you want to con-

figure.

. Click on the tab Local if you want to adjust the screensaver of the local con-

sole (at the CPU module).

Click on the tabs Remote > General if you want to adjust the screensaver of
the remote console (at the CON module).

. Under Screensaver (minutes) enter a waiting period (1 to 999 minutes) for the

screensaver.

Entering the value 0 disables the screensaver.

. Click OK to save your changes.
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Selecting a keyboard layout for inputs via OSD

If the on-screen display shows other characters than entered on the console key-
board, the keyboard layout has to be adjusted.

Make sure which keyboard layout the connected keyboard uses and configure it in
the settings of the user module.

How to change the keyboard layout of the keyboard of the user module:

1. Press Ctrl+Num (default) to open the on-screen display.
2. Select the row Console setup and press Enter.
3. Under 0SD key. layout press F8 to select one of the following options:

» German

» English (US)
» English (UK)
» French

» Spanish

» lat. American
» Portuguese

4. Press F2 to save your settings.

1. Click on KVM Extenders > [All Extenders] on the directory tree.

2. Double-click the computer module of the KVM extender you want to con-
figure.
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3. Click on the tabs Remote > General.
4. Under Keyhoard layout select one of the following options:

» German

» English (US)
» English (UK)
» French

» Spanish

» lat. American
» Portuguese

5. Click OK to save your changes.
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Resetting the default settings

NOTE: This function can be carried out only via web application.

This function is used to reset the default settings of the KVM extender. By perform-
ing this function, the default settings mentioned on page 23 are reactivated.

How to reset the default settings:

NOTE: Open the local OSD of the user module by pressing the local hotkey (default:
Alt+Num) if you want to reset the local settings of the user module only instead of
the settings of the extender system.

1. Open the remote OSD of the computer module by pressing remote hotkey
(default: Ctrl+Num) if you want to reset the settings of the extender system.

Open the local OSD of the user module by pressing the local hotkey (default:
Alt+Num) if you want to reset the local settings of the user module.

2. Select the row System setup (remote OSD) or Console utility
(local OSD) and press Enter.

3. Select the row Set system defauts and press Enter.

4. Confirm the security prompt or cancel the process.

. Click on the tools icon on the toolbar.
. Click on the tabs Tools > Default settings.

Use the information in the fields »Device« and »Comment« to check if you have selected
the right device.
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. If required, disable the option Delete network configuration if you want to keep
the configuration of the network interfaces.

. Click on Default settings to reset the default settings.

NOTE: You can also reset the default settings by pressing the Reset keys..
Further information about this topic is given on page 21.
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Changing the colour of the information display

By default, information display are shown in light green. You can adjust the colour
of the information display in your personal profile.

In addition to the default colour light green the following colours are supported:

black dark red
green dark yellow
dark blue purple)

dark turquoise silver

yellow blue

fuchsia light turquoise
white

How to change the setting of the information display:

Press Ctrl+Num (default) to open the on-screen display.

. Select the row Console setup and press Enter.

1.

2

3. Select the row Personal Pprofile and press Enter.

4. Under Display color press F8 to select the desired colour.
5

. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.

. Double-click the computer module of the KVM extender you want to con-
figure.
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3. Click on the tabs Remote > Extender systems > Personal profile.

. Under Display colour you can select the desired colour.

5. Click OK to save your changes.
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Information display

Information displays are shown temporarily (5 seconds) in the upper left corner.

ADVICE: If the temporary information display is active, you can press the hotkey
Ctrl+Caps Lock to repeat the caption.

The information display can also be shown permanently or it can be disabled
How to change the setting of the information display:

. Press Ctrl+Num (default) to open the on-screen display.

. Select the row Console setup and press Enter.

. Select the row Personal Profile and press Enter.

AW N —

. Under Display press F8 to select between the following options:

Off » information display is turned off
Temporary» information display is shown temporarily for 5 seconds (default)
Permanent» permanent information display

5. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.

. Double-click the computer module of the KVM extender you want to con-
figure.
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. Click on the tabs Remote > Extender system > Personal profile.

. Under Display select one of the following options:

Off » information display is turned off
Temp » information display is shown temporarily for 5 seconds (defaulr)
Perm » permanent information display

. Click OK to save your changes.
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Configuration

Adjusting the transparency of the on-screen display

In the default settings of the KVM switch, the on-screen display covers parts of the
screen content. However, the parts of the screen contents covered by the OSD are
still visible.

You can adjust the transparency level or turn the transparency off.

How to adjust the transparency of the on-screen display:
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1. Press Ctrl+Num (default) to open the on-screen display.
2. Select the row Console setup and press Enter.

3.
4

Select the row Personal Profile and press Enter.

. Under 08D transparency press F8 to select on of the following options:

high » high transparency of the screen content

average » average transparency of the screen content (defaulr)
low » low transparency of the screen content

off » screen content is covered

. Press F2 to save your settings.

. Click on KVM Extenders > [All Extenders] on the directory tree.

. Double-click the computer module of the KVM extender you want to con-

figure.

3. Click on the tabs Remote > Extender system > Personal profile.

. Under 0SD transparency select one of the following options:

high » high transparency of the screen content
average » average transparency of the screen content (default)
low » low transparency of the screen content

»

off screen content is covered

. Click OK to save your changes.
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Changing the position of the information dispaly

In the default configuration, the information display is shown at the left upper cor-
ner of the console monitor. However, you can adjust the position to your liking.

How to change the position of the information display:

BN N =

. Press Ctrl+Num (default) to open the on-screen display.
. Select the row Console setup and press Enter.
. Select the row Personal Pprofile and press Enter.

. Select the row Set display position and press Enter.

. Use the arrow keys or the mouse to move the

The message on the right is shown at the current [+
position of the information display. Display position
F2: Save

menu to the desired position or press Ctrl+D to reset the default position..

. Press F2 to save your settings or Esc to cancel the process.

Changing the position of the on-screen display

By default, the on-screen display is shown at the centre of the console monitor. You
can adjust the position to your liking.

How to change the position of the on-screen displays:

[ N

(o)

. Press Ctrl+Num (default) to open the on-screen display.
. Select the row Console setup and press Enter.

. Select the row Personal Pprofile and press Enter.

. Select the row Set menu position and press Enter.

. Use the arrow keys or the mouse to move the on-screen display to the

desired position or press Ctrl+D to reset the default position.

. Press F2 to save your settings or Esc to cancel the process.
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Further information

DDC transmission with cache function

The KVM extender supports Enhanced-DDC (Enhanced Display Data Channel) to read
out the data from the monitor that is connected to the user module and transmit
them to the computer. This data includes information regarding the preferred reso-
lution and the supported monitor frequencies.

To make sure that the computer connected to the computer module
(DP-Vision-IP-CPU) can already access the features of the remote monitor during boot-
ing, the KVM extender contains a cache function. Even when the computer module
or the user module are switched off or the devices are not interconnected, the
properties of the most recently connected monitor or a default data block are pro-
vided in the KVM extender.

The monitor’s DDC information is usually transmitted one-to-one to the computer.
Should the KVM extender determine that the display cannot be read without errors
or that the entries are invalid, the information is completed or corrected (if possible).

Determining network settings via service port

If you do not know the IP address of an already configured user or computer mod-
ule, you can use the service port of the module to find out the address.

Use any terminal emulator (e.g. Tera Term or PuTTY) to show the log messages of
the modules.

Installing the device driver

Before establishing a connection using the terminal emulator, install the device
driver CP210x USB to UART Bridge VCP.

NOTE: When connected to a service cable, the driver provides the Service port of a
user or a computer module as a virtual serial interface (COM port). The virtual
interface can then be selected to establish a connection using the terminal emula-
tor.

How to install the device driver to address the service port:

1. Use any web browser to open the website www.gdsys.de.

2. Go to Downloads > Tools & Driver.

3. Download the device driver for the operating system installed on the computetr.

4. Execute the file and follow the instructions of the installation wizard.

53 - G&D DP-Vision-IP



Further information

Establishing a connection by using a terminal emulator

How to establish a connection using a terminal emulator:
1. Start any terminal emulator (e.g. Tera Term oder PuTTY).

2. Establish a new connection via terminal emulator and enter the follwoing set-
tings:

= Bits per second: 115.200

= Data bits: 8
= Parity: None
= Stop bits: 1
= Flow control: None

3. Use the supplied USB service cable to connect the computer to the Service port on
the front panel of the user or computer module.

Determining the IP address
How to determine the IP address of a user or computer module:

1. Restart the user or computer module.
During the boot process, the terminal emulator shows various status messages.

2. After the boot process, the IP address and other system information are displayed.
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Pin assignment of the RS232 socket/interface

The following figures show the pin assignments of the RS232 plug as well as the
RS 232 socket:

User module Computer module
(1]2]3]4]5] (5] [4][3][2] [1]
“\ omoa | © D\ wmme | ©
RS232 plug RS232 socket

The table shows how the different lines of the data connection are assigned to the
according pins:

Pin no. Line User module Computer
module

1 DCD (Data Carrier Detect) Input Output

2 RxD (Receive Data) Input Output

3 TxD (Transmit Data) Output Input

4 DTR (Data Terminal Ready) Output Input

5 GND (Ground) Ground Ground

6 DSR (Dataset Ready) Input Output

7 RTS (Request to Send) Output Input

8 CTS (Clear to Send) Input Output

9 not occupied n/c n/c
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Status LEDs

Status LEDs

The LEDs on both the front and the back panel of the computer module and the
user module let you control the operational status of the KVM extender at any time.

Meaning of the LEDs

Area LED Color Status Meaning
Ident. Ident. blue on On as soon as the LED has been activated
via web application.
Power Red. green on The optional power pack is connected and
supplies voltage of 12 Volt.
off The optional power pack is not (properly)
connected.
Main green on The power pack is switched on and supplies
the required voltage.
off The power pack is switched off or a connec-
tion to the power network could not be
established.
Status K/M green on The keyboard has been detected.
blinking  No keyboard connected or keyboard could
not be detected.
System green  on Device is ready for operation.
blinking  Executing update.
fast Device is reset to default settings after
blinking pushing the Reset button for a long time.
red on Internal error
Channel  Video yellow on A stable video signal has been detected at
the video input.
off The incoming video signal could not be
detected or its quality is not good enough
to be processed.
Pairing yellow on The connection to the remote station has
been established.
off The connection to the remote station could

not be established.

G&D DP-Vision-IP - 56



Status LEDs

Area LED Color  Status Meaning
Network  left yellow  on Connection to remote station has been
established.
off Connection to remote station has not been
established.
right green on Connection to remote station has been
established.
off Connection to remote station has not been
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Technical data

General features of the series

DP-VISION-IP SERIES

Interfaces for Video: » see specific features
]I PS/2 keyboard/mouse: 2 x PS/2 socket
USB keyboard/mouse: 1 x USB-B socket
Audio: 3.5-mm jack plug (Line In)
3.5-mm jack plug (Line Out)
RS232: 1 x RS232 socket
Interfaces for Monitor: » see specific features
remote console PS/2 keyboard/mouse: 2 x PS/2 socket
USB keyboard/mouse: 2 x USB-A socket
Generic-HID: 1 x USB-A socket
Audio: 3.5-mm jack plug (Speaker)
3.5-mm jack plug (Micro In)
RS232: 1xRS232 plug
Interfaces for Monitor: » see specific features
local console PS/2 keyboard: 1x PS/2 socket
USB keyboard/mouse: 2 x USB-A socket
Other interfaces Connection to network: 1 x RJ 45 socket (1000 MBit/s)
Service: 1 x Mini-USB socket (type B)
Graphics Format: DisplayPort (DP 1.1a)
Colour depth: 24 Bit
Pixel encoding: RGB 4:4:4 with24bpp/8bpc
Videobandwidth: 25t0 300 MP /s

Max. resolution:

= 2560 x 1600 (60 Hz

Exemplary resolutions:

)
= 4096 x 2160 (30 Hz)
)

= 3840 x 2160 (30 Hz
x 2048 x 2048 (60 Hz
= 1920 x 1200 (60 Hz

» further standardised resolutions
possible

Vertical frequency:

24 Hzto 120 Hz

Horizontal frequency:

25 kHz to 185 kHz
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DP-VISION-IP SERIES

Audio

Transmission type:

transparent, bidirectional

Resolution: 24 bit digital, Stereo
Sampling rate: 96 kHz
Bandwidth: 22 kHz

RS232 Transmission type: transparent

Main power supply

Redundant power suppply

Transmission rate:

max. 115.200 bit/s

Supported signals: RxD, TxD, RTS, CTS, DTR, DSR, DCD
Type: internal power pack

Connector: IEC plug (IEC-320 C14)

Voltage: AC100-240V/60-50Hz

Type:
Connector:

external power pack
miniDIN-4 Power socket

Voltage:

+12VDC
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Specific features of devices

DP-VISION-IP-AR-CPU

Interfaces for Monitor: 1 x DisplayPort jack

local console

Interfaces for Video: 1 x DisplayPort jack

computer

Casing Material: anodised aluminium
Dimensions (Wx Hx=D): 210 x 44 x 210 mm
Weight: approx. 1.3 kg

Current consumption Main power supply: 100-240 VAC/60-50 Hz/0.3-0.2 A
Redundant power suppply: 12VDC/@.9 A

Operating environment ~ Temperature: +5 to +45 °C
Air humidity: <80 %, non-condensing

DP-VISION-IP-AR-CON

Interfaces for Monitor: 1 x DisplayPort jack

remote console

Casing Material: anodised aluminium
Dimensions (Wx Hx=D): 210 x 44 x 210 mm
Weight: approx. 1.3 kg

Current consumption Main power supply: 100-240 VAC/60-50 Hz/0.3-0.2 A
Redundant power suppply: 12VDC/1.2 A

Operating environment ~ Temperature: +5 to +45 °C
Air humidity: <80 %, non-condensing
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Das Handbuch wird fortlaufend aktualisiert und im Internet verdffentlicht.

The manual is constantly updated and available on our website.
http://gdsys.de/A9100303

Guntermann & Drunck GmbH

Obere Leimbach 9
57074 Siegen

Germany

http://www.gdsys.de
sales@gdsys.de
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